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Micro Focus Visual COBOL Developer 8.0
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any documentation updates.

Product Overview

Important:

• This package only supports Intel platforms.
• Only Micro Focus AutoPass licenses are provided.

The package comprises the following products which you can download from your Electronic Product
Delivery Note:

• Visual COBOL for Visual Studio - delivers the richest development experience for COBOL programming
available on Windows using Microsoft's Visual Studio 2017, 2019, or 2022. Visual COBOL supports the
development and deployment of both managed .NET and native COBOL applications.

• Visual COBOL for Eclipse - provides an Eclipse-based integrated COBOL development environment for
Windows or Linux. Provides COBOL JVM support and enhanced compatibility with ACUCOBOL. Can
be used standalone for developing local applications or in conjunction with the Development Hub to
develop remote projects in Linux and UNIX.

• Visual COBOL Development Hub - provides a rich desktop development environment based on the
Eclipse IDE with high-performance server-based tools for managing builds, source code access and
debugger engine. The Development Hub also provides a central administration site, simplifying the
development tool distribution and maintenance process.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
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run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.

If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.
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What's New
Enhancements are available in the following areas:

• Micro Focus COBOL Extension for Visual Studio Code
• .NET 6 Support
• COBOL Language Enhancements
• Code Analysis
• Compiler Directives
• Data File Tools
• Debugging
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration
• Enterprise Server Security
• Micro Focus Unit Testing Framework
• Open ESQL
• Visual Studio Integration

Micro Focus COBOL Extension for Visual Studio Code
Back to Top

The Micro Focus COBOL extension for Visual Studio Code provides the following enhancements:

• The use of the Micro Focus COBOL extension with Visual COBOL 8.0 installed on the same machine
enables COBOL Language Server support. This offers a rich COBOL editor experience inside Visual
Studio Code including IntelliSense, Peek Definition, and Rename.

Note: The Micro Focus COBOL extension is available from the Microsoft Visual Studio Marketplace - 
click here.

.NET 6 Support
Back to Top

This release provides the following enhancement:

• You can create, build and run COBOL projects targeting .NET 6 in Visual Studio 2022. In all other
supported environments, you can use the .NET 6 SDK or Visual Studio code to build .NET 6 COBOL
projects.

Support for .NET Core 3.1 has been discontinued.

COBOL Language
Back to Top

The following enhancements have been made to the Micro Focus COBOL language:

• Further support for IBM Enterprise COBOL 6.3:
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• JSON PARSE and JSON GENERATE statements - for JSON GENERATE, anonymous objects can
be generated using the OMITTED key word; the SUPPRESS phrase has been enhanced; the
CONVERTING phrase is supported. For JSON PARSE, anonymous objects can be parsed using the
OMITTED key word; the CONVERTING phrase is supported.

• Intrinsic functions - the following list of functions is now supported: COMBINED-DATETIME,
FORMATTED-CURRENT-DATE, FORMATTED-DATE, FORMATTED-DATETIME, FORMATTED-
TIME, INTEGER-OF-FORMATTED-DATE, SECONDS-PAST-MIDNIGHT, SECONDS-FROM-
FORMATTED-DATE, TEST-FORMATTED-DATETIME, and UUID4.

• The AMODE Compiler directive has been enhanced to allow COBOL programs full access to the 64-
bit address space (AMODE"64"). This emulates the LP"64" option in Enterprise COBOL.

• The DYNAMIC LENGTH clause, introduced in the last product release, is now supported in .NET
COBOL and JVM COBOL (as well native COBOL).

• JVM COBOL.NET COBOL enhancements:

• When no explicit type is declared for a variable, but the value is a non-integer numeric (for example
declare var1 = 1.23), it is assumed to be of type float-long.

• The NAME OF expression has been introduced. It returns the unqualified name of the type or
member specified.

Code Analysis
Back to Top

The Application Analysis Server enables you to access either Micro Focus Enterprise Analyzer or COBOL
Analyzer from the IDE. This release includes the following enhancements to this feature:

• A generate code search report and a single code search reports are available.
• An improved Get Direct References report.

Enhancements to the Analysis Services include:

• An enhanced Program Flow Graph
• Support for displaying the Data Flow analysis as a Graph.
• A new Eclipse preference page, Application Wide Knowledge in Window > Preferences > Micro

Focus > COBOL > Code Analysis. This enables you to adjust certain timeout settings for certain long-
running queries executed against a remote Enterprise Analyzer or COBOL Analyzer server.

Enhancements in the Rule-Based analysis include:

• The Micro Focus Code Analysis project's properties page in Visual Studio, and the Micro Focus
Code Analysis Manager dialog box now support subfolders in the rulesets.

• The Rules preference page in Window > Preferences > Micro Focus > COBOL > Code Analysis
now supports nested rules.

Compiler Directives
Back to Top

The following Compiler directive is new in this release:

• DISPLAY-PICU - defines the way PIC U data items are displayed: either as ANSI or UTF-8.

The following Compiler directive has been enhanced in this release:

• AMODE - a new parameter "64" stores pointers in 64-bit format - see COBOL Language Enhancements
for more details.

What's New | 7



Data File Tools
Back to Top

The following enhancement has been made to the Data File Tools:

• The Data File Editor now supports opening and editing KSDS VSAM files stored in an MFDBFH
datastore.

Debugging Applications
Back to Top

This release includes the following enhancements:

• Locals window support for native COBOL in Visual Studio - during debugging, the Locals window now
displays the names of the variables available on the current statement.

• In Eclipse, the Enterprise Server debug configurations can now configure the Program breakpoint on
main entry point only option, which if selected, only breaks execution when the Procedure Division
entry point is called.

Eclipse
Back to Top

Enhancements are available in the following areas:

Product:

• This release supports Eclipse 4.20 (2021-06), which is shipped and installed with Visual COBOL.
Versions of Eclipse prior to this one are not supported.

Projects:

• Apache Maven support - native COBOL and native COBOL Unit Testing projects can be incorporated
into your Maven-based lifecycles. They now accept a pom.xml file, which can be configured to run the
Maven AntRun plugin, which allows Ant-based projects to work with Maven.

• Automatic directives determination - it is now possible to specify if this should run and if you will be
prompted to perform it from Perform automatic directives determination preference, available from
Window > Preferences > Micro Focus > COBOL > Directives Determination.

• Code Clean Up - you can configure code clean up preferences, which you can apply to your code to
ensure consistency throughout your COBOL code (for example consistent use of the PIC or PICTURE
keyword). These preferences are stored in profiles, which allows them to be shared among
development teams.

• Multi-file compilation - right-click a selection of files, and click Compile when Automatic Build is
disabled. This utilizes the Maximum compilations/links to execute concurrently option (available
from Window > Preferences > Micro Focus > Builder > Project) for native COBOL projects.

• Order of the Copybook Paths list - it is now possible to control the initial position of the new directory in
the list. Use the Insert to the beginning of copybook paths list or Append to the end of copybook
paths list options to determine the position. These options are available from Window > Preferences
> Micro Focus > Builder > Project.

COBOL Editor:

• COBOL code mining - code minings are additional content shown in the COBOL editor to give extra
context to certain code elements. Use the Window > Preferences > Micro Focus > COBOL > Editor
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> Code Minings page to enable an indicator showing the number of times that a section or a paragraph
is called in your native or procedural JVM COBOL code. Select the link shown to show a list of
references in the Search view, where you can use the matches shown to jump to the actual call within
your code.

• end- delimiter tooltips - within the COBOL editor, if you hover over the end- delimiter of a statement
such as an IF or an EVALUATE statement, a tooltip showing the opening clause of the statement is
displayed. You can enable/disable this behavior from the Block matching section in the COBOL editor
preferences.

Enterprise Server
Back to Top

This release provides enhancements in the following areas:

• EZ Sockets now supports up to 4096 sockets on Linux, up from 1024, and enhanced tracing.

• EZ Sockets applications, including ones that use the CICS listener CSKL (EZACIC02), can have
more simultaneous connections.

• EZ Sockets tracing now has options for logging the recent history only when any error or one of a set
of particular errors occurs. This makes it easier to use tracing to diagnose EZ Sockets issues.

• Enterprise Server dataset management - dataset maximum retention period with the ability to alter and
create reports:

• ES_JES_ENFORCE_EXPIRE_DATE - helps determine whether or not to check the expiration date
when deleting a catalogued dataset, and if expired, delete the dataset. If it hasn't expired and the
PURGE option has not been specified, the dataset is not removed. The PURGE keyword is required
to delete non-expired datasets. PURGE removes the underlying physical dataset file unless it is
referenced by another catalog entry. SMS MANAGEMENTCLASS now supports maximum RETAIN
days. See Using SMS MGMT Classes and the %SMS example command in the same topic.

• ES_JES_LISTCAT_YMD - helps determine the date format used in the HISTORY report generated
when the IDCAMS LISTCAT command specifies the ALL option.

• The EXPDT entry in a DD statement must be a four-digit year (YYYY); otherwise 1900 is the default,
which is in-line with the mainframe processing, and prevents unexpired datasets from being
erroneously removed (as was the case with the previous default of 2000). The ALTER command now
takes the TO and FOR options to enable specification of the retention period for the entry being
altered. The maximum retention period might be limited by the management class. The IDCAMS
LISTCAT command ALL parameter now generates a separate HISTORY report that shows the
creation date time and job, the last changed date time and Job, and the expiration date.

• HTTP compression - the Communications Server supports compressing large HTTP responses with
gzip, and handles gzip-compressed HTTP requests. The Common Client supports gzip-compressed
HTTP responses. Some large HTTP responses are compressed automatically if the client supports it.
Large HTTP messages can be compressed, saving network bandwidth and improving performance.

• Task-cleanup performance - the performance of post-processing for tasks in MFCS has been improved.
• ICETOOL emulation - now supports the COUNT+n and COUNT-n syntax during trailer processing,

where n is a numeric between 0-999. This adds to or subtracts from the COUNT value.
• Enterprise Server configuration - you can now change the recording directory of the dump, trace, HSF,

and the console.log files of each region. See Alternative Enterprise Server Output Locations for
more information.

• Compression on ECI calls via CASBNCCL Client - when using the Micro Focus External Call Interface
(ECI) over TCP/IP, the request and response data flows are now compressed using RLE.

Enterprise Server Common Web Administration (ESCWA)
Back to Top
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This release includes the following enhancements:

• Oracle Coherence is now available as a PAC Scale-Out repository as an alternative to Redis.
• Reduced number of Redis instances required when a PAC incompatible upgrade is performed - it is now

possible to have multiple PSORs in one REDIS instance. This allows for the REDIS instances
provisioned in the PAC to be reused.

• Enhanced PAC diagnostics via CTF - a new option on the ES Control page is now available to enable or
disable CTF for a running region without the need to recycle the region.

• ESCWA API, version 2 - includes updated versions of some of the existing API, version 1 endpoints,
with improved JSON property names, more sensible URIs. The version 2 API is a single API standard
across API endpoints. It includes a number of usability enhancements, has a better readability and
discoverability, and includes an improved API documentation.

• Enterprise Server Configuration Manager

• A variety of configuration options are available in ESCWA on the General >Advanced page for a
region.

The property grid in ESCWA shows the full list of configurable properties, categorized by group,
along with help text and some additional meta-information. Properties marked as dynamic in the
property grid can also be updated in a running region.

• A number of properties that were previously set with environment variables are now available in the
ESCWA UI. The environment variables are still supported for backward compatibility.

• Accessibility enhancements - the ESCWA UI includes a number of improvements in the areas of
usability with screenreaders, color contrast, and text and icon sizing and alignment. This is to give it an
improved compliance with the 508 and WCAG 2.1 standards.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

• AWS Secrets Manager - support is available for using an AWS Secrets Manager, mfsecretsaws, as a
remote vault. See The mfsecretsaws Vault Provider .

• Protection for sensitive data - some sensitive data is now protected in the memory. This helps reduce
the risk of exposing sensitive data such as passwords in core dumps and similar scenarios.

• An option to update short names - the ESF Update mechanism enables you to change between OS
users ("long names") and ES userids ("short names") in running regions. This requires a non-default
configuration setting.

• Caching improvements - ESF caching now caches more types of requests. This helps improve the
Enterprise Server latency and throughput when external security is configured with caching.

• Support for Argon2 in password history - when Micro Focus passwords are used with the MLDAP ESM
Module and password history is enabled, use Argon2 password verifiers in the history to avoid the
potential exposure of passwords via weaker verifiers. This helps improve the security of the password-
history mechanism.

• The product Help includes a new section, Securing Enterprise Server, which provides guidance on
improving the security of Enterprise Server installations and the applications they host. This includes
information on security and how to reduce security exposure.

Micro Focus Unit Testing Framework
Back to Top

The following enhancement has been made to the Micro Focus Unit Testing Framework in the IDE:
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• IDE support has been added for self-contained tests.

The following enhancement has been made to the command-line version of the Micro Focus Unit Testing
Framework:

• You can now use the Micro Focus Unit Testing Framework to build and run test cases from within
a .NET 6 environment. Install the NuGet package supplied with Visual COBOL to enable the mfunit
extensions to the dotnet command line utility.

OpenESQL
Back to Top

This release includes the following enhancement:

• The new SQL Error Mapping feature enables you to customize how error information is returned in
SQLCODE, SQLSTATE, SQLERR and MFSQLMESSAGETEXT. For details, see SQL Error Mapping in
your product Help.

Visual Studio
Back to Top

• Support is now available for Visual Studio 2022.
• Syntax coloring for COBOL in the editor had been improved for identification divisions, copybooks

references using COPY... REPLACE statements, and EXEC blocks.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Case Number followed by the Defect number (in
parentheses).

• Code Analysis
• Common Communications Interface
• Compiler
• Containers
• Eclipse IDE
• Enterprise Server
• Machine Administration
• File Handling
• Micro Focus Directory Server
• Run-time System
• SQL: OpenESQL

Code Analysis

Back to the list

• Rules in nested folders are now correctly processed, as well as rules with the same name.

(207020)

Common Communications Interface

Back to the list

• For improved security, SSL/TLS connections are now restricted to TLS versions 1.2 and 1.3 by default.
This is an industry best practice. If you need to use older, less-secure protocol versions with legacy
clients or servers you should consult the product online help for instructions on configuring TLS protocol
versions.

PSEC:103001 (87188)

Compiler

Back to the list

• When a RELEASE or RETURN statement is executed in an input or output procedure of a sort
statement, if the SORT-RETURN special register is found to contain a value of 16, then the sort should
be aborted, even in a case where the RELEASE or RETURN statement is at a lower perform level than
the input or output procedure itself. Previously, this was not happening for programs compiled to JVM
or .NET COBOL, but this erroneous behavior is now fixed.

01723392 (104114)
• When a variable is defined in a DECLARE statement with no explicit type, but a value that is a non-

integer numeric literal, the type is assumed to be float-long (i.e. a 64 bit floating point).

(148103)
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Containers

Back to the list

• The containers image build tool now supports custom Java run-times which helps to keep the size of
Java-based applications smaller. 

(182004)

Eclipse IDE

Back to the list

• COBOL formatter functionality has been enhanced with the introduction of a 'Code Clean Up' feature.
The code clean up preferences are stored in profiles, similar to the COBOL formatter preferences, and
are also applied in a similar way, within the COBOL editor. See Formatting COBOL code in the
documentation for more details.

(123034)

Enterprise Server

Back to the list

• The Security Manager passwords no longer appear in the commonwebadmin.json configuration file.

(203052)
• The X-XSS-Protection header will now be set on all requests instead of only on API requests.

01938835 (138176)
• In ESCWA, the colors and contrast have been adjusted to improve visual accessibility.

01995403 (158071)
• ESCWA now displays an improved message if there is an issue with loading the application, especially

in the case where there is a browser incompatibility.

(241013)
• ESCWA now handles enterprise server regions that use character encodings other than windows-1252.

00370773 (11742)
• In ESCWA, the Console Log page now enables you to easily traverse and navigate the log. The new

paging feature uses an API call from the Communications Server group documented in the Enterprise
Server Administration Server API, typically located at http://localhost:10086/docs/#/
Communications_Server on the machine where you have the product installed.

02085456 (191017)
• ESCWA now supports multiple PACs in a single Redis store.

(248003)
• ESCWA now handles enterprise server regions that use character encodings other than windows-1252.

(91001)
• In ESCWA, on the Communications Process page you can now specify a Requested Status for the

communications process.

00669779 OCTCR50A69378 (69378)
• In ESCWA, the Catalog DCB page now displays the file size in bytes.

01909652 (138002)
• ESCWA now supports Circular Logging. On the Tracing and Logging Settings page you can now

specify the Log Max File Size and the Log File Count fields. By default, these fields are set to 1024kB
and 5 respectively. See Tracing and Logging Settings in your product Help for more information.

02083633 (191019)
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• In ESCWA, a new optional Logon security resource has been added. This can be used to control
users' ability to log on. See Security Resources to Control ESCWA and API Access in your product Help
for more information.

01886579 (124022)
• You can now define and install shared SOR Models. In the SOR Model dialog box, check Shared to

enable the SOR Model to be shared between PACs. 

(244088)
• For LDAP-based security in Enterprise Server, the processing of password changes has been modified

to address security issues, inconsistencies among configurations, and other issues. See Understanding
passwords with LDAP-based security in your product Help for more information.

(118088)
• Enterprise Server with LDAP-based security now denies a sign-on attempt by default if it includes a

password-change request (a new password is supplied), and the password change fails. This was the
existing behavior in some configurations but not in others. It is now consistent and configurable. See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

(108046)
• A change has been made to the way that TS queues and TD queues are stored in a PAC. This was to

ensure that deleting a 0TSQ did not also delete all queues that had a 0TSQ_ name prefix.

Note: After the update is applied you must cold start your PAC.

(183044)
• In a PAC, the SIT setting is now honored when a TS or TD is to be applied to the enterprise server

region if the TS or TD is not under a SOR, MFDBFH, or Fileshare. This means that if a SIT has to cold
start for TS or TD and the files are either in the workarea or on disk then the SIT settings will be applied,
otherwise the PAC-wide settings will be applied.

02149316 (204020)
• EZASOKET traffic will now be assigned to Communications Process instance #1. You might need to

consider this if you use load balancing.

02060014 (201009)
• When a PAC is cold started, the configuration file specified by MFDBFH_CONFIG will be uploaded to

the PSOR and a temporary file created in the enterprise server region’s workarea. This temporary file
will be used by all the processes for that enterprise server region. Subsequent enterprise server regions
joining the PAC will then create a temporary file in its workarea for the MFDBFH_CONFIG from the
PSOR store. If an enterprise server region in the PAC is killed or is terminated abruptly than the restart
of the enterprise server region will try to recover the previous UUID left in the PAC and DEQ all
remaining ENQs in MFDBFH that were created from the previous run. New messages will be created in
the console.log identifying if the recovery was initiated and successful, if the enterprise server region
could not be recovered automatically, the region will stop. A log file will be created in the workarea with
the following file naming convention:

 Caspac_Recover_UUID_xxxxxxxxxxxx.log

For example: CASCD4012W Region was not stopped properly, recovering previous region UUID
14BAAA87B4C010BFBDE278A5F65B350C 18:15:17CASCD4014I UUID recovery file log C:\Users
\mag.CORPDOM\Documents\Micro Focus User\Enterprise Developer\WORKAREA
\RAS1\Caspac_Recover_UUID_14BAAA87B4C010BFBDE278A5F65B350C.log 18:15:18. Using
the caspac utility with the -aStatus parameter will display if the enterprise server region in a PAC has
lost its connection to the PSOR. If you determine that the region is no longer in the PAC, then you can
run the caspac utility with the -aRecoverUUID parameter to recover the enterprise server region. If
the -aRecoverUUID parameter is used, then a file will be created in the current directory with the
following file naming convention:
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02081952 02123645 (182093)

Caspac_Recover_UUID_xxxxxxxxxxxx.log. 

See caspac in your product Help for more information.
• Functions have been added to file_utilities which check a given file name against either a default

blacklist containing operating system reserved file names, or a passed blacklist. Read, write, and delete
in AES and MSCPD use this function to disallow secret names which are inappropriate names.

OCTCR50A7844 (112022)
• Fileshare is no longer used to locate the Resource Definition and CNV file.

00468648 (69010)
• MQ updates did not rollback on step failure. This has been fixed.

01976727 02161235 (155010)
• PSOR stores are now prefixed by the PAC NAME and a version number enabling you to run multiple

PACs in the same PSOR, simplifying the incompatible upgrade process. The caspac utility enables you
to add the PAC Name as part of the command line parameters using -pPACName or if not specified
using the ES_PAC environment variable. See caspac in your product Help for more information.

(202162)
• The XA reconnect mechanism now attempts to reconnect to all XA entries marked as "enabled" at the

start up of the enterprise server region. To prevent the reconnect attempts, do one of the following:

• Remove the XA manager from the enterprise server region definition.
• Set the XA manager as disabled before starting the enterprise server region.

01991481 02003277 (151008)
• A new MLDAP ESM custom configuration section has been added. The [Prefix Search] option

enables the Prefix Search wildcard optimization for limiting the scope of wildcard resource entities
checked under a resource class. See MLDAP ESM Module Custom Configuration Information in your
product Help for more information.

00726158 (73180)
• For LDAP-based security in Enterprise Server, the processing of password changes has been modified

to address security issues, inconsistencies among configurations, and other issues. See Understanding
passwords with LDAP-based security in your product Help for more information.

(118088)
• Enterprise Server with LDAP-based security will now by default deny a signon attempt if it includes a

password-change request (a new password is supplied), and the password change fails. This was the
existing behavior in some configurations but not in others. It is now consistent and configurable. See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

(108046)

File Handling

Back to the list

• The dbfhadmin utility has been enhanced to allow the integrity of a datastore to be verified, and
optionally, fixed up: use the dbfhadmin -verify -list|-recover options. See The dbfhadmin
Command Line Utility in your product Help for more information.

00778044 (90143)
• The dbfhadmin command-line utility has been enhanced to provide the capability for verifying and

optionally repairing (cross-)region databases.

02123645 (193071)
• The cross-region database heartbeat interval can now be configured using the dbfhconfig -add|-

update -heartbeat interval-in-seconds command. The default heartbeat interval remains as
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5 seconds. A warning message is now output to the Enterprise Server console during region database
start-up if the heartbeat interval is configured to be >15 seconds. The larger the heartbeat interval, the
longer the time that is required to be able to recover (cross-)region database resources. Recovery can
only take place for a process if its associated heartbeat record has not heartbeat within the last
"heartbeat-interval + 5" seconds.

02155269 (202149)
• The performance of PostgreSQL optimized I/O has been improved. If you use the psqlodbc device

driver, you will need to ensure that you are running with version 12.02.0000 or later. This change has
been tested with version 13.01.0000. To take advantage of the performance benefits of this change,
specify BatchSize=100 for each of your ODBC DSNs. Using a version of the driver earlier than
12.02.0000 could result in a performance degradation when deploying large files to datastores.

(125032)
• Table record locking and database record locking are incompatible and may lead to data corruption if

used together by separate processes when processing the same file. MFDBFH has been enhanced to
ensure that if a file is already opened in a process with table locking, all other processes attempting to
open the same file, even if requesting database locking, will also use table locking. However, if a
process has a file opened using database locking, other processes attempting to open the file will only
be allowed to do so if they are transactional files (i.e. database record locking can only be used for
transactional files). An attempt to open the file as non-transactional will fail. Refer to the Record Locking
Strategies documentation for more information.

(102011)
• MFDBFH now enforces the existing requirement that a region database used by a PAC, or a region

database used by an ES region configured to use ES_LOCK_DB, is not used by any other PAC or
ES_LOCK_DB regions. This is necessary to avoid problems such as jobs with the same name
submitted to two separate regions, but erroneously using the same region database, from being blocked
by waiting on SYSZJOBD and/or SYSZJOBN ENQs. A check is now performed during region start-up to
ensure that the region database is not already being used by another region, If it is, the region start up
will fail, with error messages indicating the cause of the failure output to the ES console. Existing ES
PACs/regions will need to be stopped and restarted for these new region database state checks to take
effect. The dbfhadmin -region -status [-reset] command has been introduced to allow a
region database's state to be displayed and, optionally, reset. See Resource Locking in your product
Help for more information..

(121030)

Machine Administration

Back to the list

• A problem with using the .NET 3.5 framework has been fixed.

(204144)
• A problem with CPU conversion has been corrected.

(199042)

Micro Focus Directory Server

Back to the list

• The mfds /s option supports the specification of the optional Enterprise Server user id and
password parameters using a configured Micro Focus Vault Facility location rather than using literal
strings for credentials. For example:

mfds /s 1 mfsecret:user/user_001/id mfsecret:user/user_001/pwdwhere user/
user_001/id and user/user_001/pwd
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Are secrets stored in the default-configured vault. These values can be populated and administered
using the mfsecretsadmin utility. See Vault Facility in your product Help for more information.The
mfds /x and /g command-line options also support credentials stored in the vault.

02131532 (193088)
• If MFDS is configured to store sensitive values in the vault (for example, XA openstring or autostart

credentials), these values were not being included in legacy data format or XML export of Enterprise
Server configuration information. Subsequently, these values could not be reimported. These sensitive
values are now included in the exported data. Micro Focus recommends that you protect the exported
files with appropriate access control.

(202272)

Run-time System

Back to the list

• The native COBOL multi-threaded demo is now available for Windows development products.

(3765)
• Basic support for xterm-256color has been implemented.

(57591)

SQL: OpenESQL

Back to the list

• A performance problem in a SQL program using fixed-length character arrays when compiling a COBOL
program and using array fetch has been resolved.

02152406 (203060)
• A new feature to assist migration between databases has been added. SQL error codes and messages

may be mapped to different values or supressed to match those expected by the application.

(193003)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• Problems with Microsoft's Visual Studio 2022, release 17.2, might cause the following issues with Visual
COBOL or Enterprise Developer for Visual Studio 2022. The issues do not exist in release 17.1. See
the points below for the workarounds to these issues:

• An issue with Microsoft's Visual Studio installer might result in the IntelliSense and editor colorization
not working. To repair your installation, execute the following command from a Visual Studio
command prompt:

devenv /updateconfiguration

This issue is resolved by Microsoft in Visual Studio 2022, release 17.3. You need to update your
Visual Studio installation.

• Mixed-language multi-project builds might fail as a result of the project dependencies not working
correctly. This means that some projects might build in parallel when they should build in a specific
order. As a result, the build might fail due to a dependency not always being available. To work
around this issue, click Tools > Options > Preview Features, and check Load projects faster
(some features may be delayed).

This issue is resolved by Microsoft in Visual Studio 2022, release 17.3. You need to update your
Visual Studio installation.

• The expanded copybook visualizations are missing. This includes breakpoint, current statement
when debugging, and others. These features might not always function correctly in non-expanded
source (in the main programs) if that program contains expanded copybooks. To work around this
issue, you can disable inline copybook expansions.

• Visual Studio 2022 requires that the global.json file of .NET 6 projects is placed at the directory
level of the solution file in order for the project to successfully open and build. In previous versions of
Visual Studio, the file could be located in subfolders of the solution such as in the project folder.

This can affect existing .NET Core 3.1 COBOL projects that you upgrade from a prior release if the
global.json file is not at the directory level of the solution file. It also affects .NET 6 COBOL projects
that you add to an existing solution.

In these cases, you might receive the following error message if building from the MSBuild command
line, or in the IDE Output window if the project fails to load:

"The SDK 'MicroFocus.Sdk' specified could not be found"

To work around this issue, you need to move the global.json file to the directory level of the solution
file.

New .NET 6 COBOL solutions and projects created with VS2022 create the global.json file in the
required location.

• It is not possible to upgrade from a 7.0 version of the Visual Studio-based product, if you are targeting a
different version of Visual Studio. For example, it is not possible to upgrade from Visual COBOL 7.0 for
Visual Studio 2017 to Visual COBOL 8.0 for Visual Studio 2019.

• It is not possible to install the 8.0 version of the Visual COBOL Build Tools as an upgrade of an existing
7.0 installation. You must first uninstall the 7.0 product.

• The Server Core form of Windows Server 2019 is not supported.
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• In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL run-
times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in the newer versions of Visual COBOL.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• Character Animator
• Code Analysis
• Common Communications Interface
• Compiler
• Containers
• Data Tools
• Dialog System
• Debugger
• Documentation
• Eclipse IDE
• Enterprise Server
• File Handling
• Interface Mapping Toolkit
• Micro Focus Common Client
• Micro Focus Directory Server
• Micro Focus License Administration
• Micro Focus Support
• Panels
• Run-time System
• Setup
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: OpenESQL
• Visual Studio Code
• Visual Studio IDE

Character Animator

Back to the list

• The cobesdebug command now functions correctly on s390 Linux machines.

02126702 (204053)

Code Analysis

Back to the list

• Some memory leaks causing a crash in the process have been fixed.

00506227 (69251)
• An issue with Data Flow analysis has been fixed.

(245019)
• Visual Studio now supports analyzing COBOL Unit Test Projects.

(234009)
• Added support for analysis using the ChildrenCount attribute.
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02068434 (174080)
• A new code rule has been added to general queries to identify COBOL statements ending with a period.

00488450 (204164)
• A new code rule has been added in general queries that identifies COBOL statements ending with a

period.

00488450 (202186)

Common Communications Interface

Back to the list

• An invalid request no longer gives an unexpected "GkCWI: OPEN: unable to open connection: (8)" on
Solaris 64-bit.

(221007)
• Improvements have been made to the validation of server certificates for SSL/TLS connections.

(244007)

Compiler

Back to the list

• 32-bit Intel x86 generated code only: when a statement of form 'set length of dynamic-item to var-a' is
followed immediate by an arithmetic statement using var-a, incorrect code could be generated. This has
been fixed.

(124033)
• JVM COBOL only: with ARITHMETIC(OSVS|VSC2|ENTCOBOL) set, a multiply expression that resulted

in zero due to truncation of least significant digits could result in a
java.lang.ArrayIndexOutOfBoundsException exception. This bug has been fixed.

02194495 (220102)
• SORT operations using files greater than 4Gb no longer fail for JVM COBOL programs launched with

the 'java' command instead of 'cobjrun'.

00779891 (101099)
• For JVM COBOL applications running in time zones that follow daylight savings, CURRENT-DATE

returns the wrong offset when the run-time tunables, current_year, current_month, current_day,
current_hour, current_minute, and current_second are set to a datetime that falls outside of daylight
savings, and the machine's time zone falls within daylight savings. This also occurs in the opposite case
where the datetime set falls within daylight savings but the machine's falls outside. Additionally, if
timewarp_dynamic is set to false, issues might occur if the machine's current time zone falls within
daylight savings while the datetime set by the run-time tunables does not (and vice versa). The hour
output in the return from CURRENT-DATE can differ depending on the actual machine time zone
setting.

When run-time tunables are left at their default values, JVM_COBOL CURRENT-DATE behavior is
correct.

(246040)
• The following code:

move address of item-1 to ptr-item

Where item-1 is a group item, created incorrect code. This has been fixed.

02108263 (189014)
• The following command:

cob -x prog.cbl
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Where prog.cbl contained user-defined functions, would create an executable with the wrong name,
which did not behave correctly. This has been fixed.

(7760)
• Spurious background parse errors no longer occur when switching between DIALECT"ENTCOBOL"

and DIALECT"MF" programs.

(246064)
• An EXEC statement containing incorrect syntax now receives a single appropriate error without

additional spurious messages.

(5093)
• COPY statements specifying a filename with an extension longer than 10 characters are now

successfully processed, as they were in earlier products.

02223965 (246061)
• A WRITE statement following a WRITE AFTER statement no longer produces extra, spurious blank

lines.

02177282 02212276 02202768 (212006)
• Use of ANY LENGTH arguments in user functions now work as expected.

00507152 (98059)
• Generation of a program with implied linkage parameters now completes successfully.

(202177)
• Use of $DISPLAY VCS = syntax in a multi-program source now compiles as expected.

02033283 (167013)
• A syntax error for a statement appearing on the same line, and after a COPY statement, is now

reported with the correct error location.

(4795)
• A syntax error for a statement appearing on the same line, and after a COPY statement, is now

reported with the correct error location.

(3860)
• INSPECT REPLACING operands of unequal size now receive a run-time system error, thus preventing

data corruption from occurring.

(4667)
• A STRING statement in a program with a large amount of data now executes as expected.

02132926 (202023)
• When scrolling upwards in Character Animator, correct source lines for nested copybooks are now

always shown correctly.

02209782 (246075)
• A bracketed abbreviated condition with implied subject and leading 'NOT' now compiles as expected.

(5249)
• Non-ASCII characters in comment entries now appear correctly in EA reports.

00428434 (87204)
• Compilation of a DECLARE statement that is missing the AS keyword now reports a syntax error and

completes without looping.

(202291)
• A Quick Browse of data names containing DBCS characters now returns correct results.

(2840)
• Reference modification on the results of an intrinsic function now returns the correct result in all

scenarios.
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(3877)
• SSRANGE messages have been enhanced to show line and file information.

00732371 (91169)
• The reference count for data items used in CALL statements is now shown correctly.

02130511 (193060)
• A program using AS as a data name now compiles successfully and is processed correctly by EA when

using an Enterprise COBOL dialect (where this is a context-sensitive reserved word only.)

(221073)
• All currency sign values that are valid for Enterprise COBOL are now correctly accepted under that

dialect.

(220072)
• In Visual Studio, Find all references for an ambiguous name that is the subject of a REDEFINES

clause now shows expected results.

02093998 (190032)
• EA analysis is now correct for an item referenced in the COUNT clause of an XML GENERATE

statement.

(222066)
• Non-ASCII characters in long comment lines are now correctly processed by Enterprise Analyzer

tooling.

(120026)
• A SEARCH ALL operation that contains another SEARCH ALL operation inside of the AT END clause

now evaluates its WHEN clauses correctly.

01829511 (110077)
• The EA and XMLGEN directives now produce separate XML files if the file name option in the EA

directive and the path option in the XMLGEN directive are both used.

01726038 (110026)
• Reference information in the IDE for qualified paragraph names is now correct.

(73204)
• The insertion of large amounts of replacement text from the REPLACE statement no longer causes

execution to hang.

01803571 (106074)
• A new directive, DISPLAY-PICU has been added to determine how PIC U items are displayed to the

console: either as UTF-8 or ANSI.

(142003)
• The TYPEDEF clause cannot be used in conjunction with the DYNAMIC LENGTH clause.

(254008)
• When used with some formats of icon file, the ILICON directive could result in a system error during

compilation. This is now fixed.

00733709 (87102)
• A new directive, ILLOADSTRING"1", has been implemented which, if specified, changes the way string

loads are generated in a program compiled to .NET. This may be useful when compiling very large
projects for which the error 'COBCH0857 System error - failure during ILASM phase' is returned.

00722937 (83144)
• The new NAME OF expression is now available in .NET COBOL, and returns the unqualified name of

the type or member specified.

(158040)
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• The new NAME OF expression is now available in JVM COBOL, and returns the unqualified name of
the type or member specified.

(158040)
• The IS GLOBAL clause is now permitted for Linkage Section items in .NET COBOL code.

(70254)
• The IS GLOBAL clause is now permitted for Linkage Section items in JVM COBOL code.

(70254)
• When compiling for JVM COBOL, large programs could sometimes produce invalid code, leading to a

java.lang.VerifyError on program load. This has been fixed.

01976935 (170014)

Containers

Back to the list

• When building a base Docker image on UNIX/Linux platforms, you can now supply the odbc or odbc-
dev parameters to install the odbc run-time library or odbc developer tools library respectively.

(183056)

Data Tools

Back to the list

• When a filter is set on a data file, records outside of the filter are no longer inadvertently deleted when
deleting filtered records.

02151283 (204027)
• In the Data File Editor, records are now inserted correctly, even when the files are not stored on the C:\

drive.

02084190 (194028)
• Within the Data File Editor, when data files are opened through Enterprise Server, they will now close

correctly when the related SEP is manually removed.

(235011)
• When working with data sets via ESCWA in the Data File Editor, if you attempt to filter the catalog

without first logging in to ESCWA, you will now be prompted to log in instead of being shown an error.
Also, entering correct login credentials after a previous failed login attempt no longer shows a 403 error,
but will instead correctly log in and open the catalog.

01984967 02031391 (163059)
• Cosmetic changes have been made to some of the Data File Editor dialog boxes to ensure that all

button/screen text is displayed correctly.

01984967 02031391 (162069)
• Within the Data File Editor, MFDBFH files (that is, those stored in a database) can now be opened as

either shared or exclusive.

(234017)
• In the Data File Editor, hexadecimal values can now be used in the Value field when applying a filter to

a data set.

02306658 (246107)
• In the Data File Editor, when the ruler is on, a vertical guideline is displayed down the page every 10

columns. Toggle the ruler off to remove the guidelines.

02306661 (246106)
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Debugger

Back to the list

• Opening a large core dump file in the debugger now displays an error if the file is too large to be
debugged.

01872464 (124123)
• Core files larger than approximately 1.5Gb can now be debugged on Windows, provided enough

memory is available to the debug process. If there is insufficient memory, error 1050 will be displayed by
the debugger.

02166754 (220131)
• Level-78 items longer than 512 bytes no longer cause the debugger to crash when querying.

02096915 (185023)
• A new argument (progbponly) is available to allow program breakpoints to be used when dynamically

debugging Enterprise Server applications - see How to debug services and applications with Enterprise
Server Dynamic Debugging in the product Help for more details.

00468081 (70023)

Dialog System

Back to the list

• The create-window, show-window and create-dialog-box events are now correctly handled when
multiple versions of a dialog system application are running.

02074907 (181035)

Documentation

Back to the list

• The list of available samples in the documentation has been corrected. Previously, it incorrectly stated
that the 'airport demo' was an available sample on Linux/UNIX platforms.

(10126)
• Due to restrictions now placed on the target type of applications from which a program test originates

has meant a tweak to the Running Unit Tests in the IDE tutorial in Eclipse.

(231020)
• Context-sensitive help now exists when editing a clean-up profile (Window > Preferences > Micro

Focus > COBOL > Code Style > Clean Up)

(211016)
• Some minor changes have been made to the Packaging JVM COBOL tutorial in the documentation.

(230027)
• Minor amendments have been made to the Compiling a COBOL Program to JVM Byte Code tutorial in

the documentation.

(230025)
• Minor and cosmetic changes made to the documented Creating a Native COBOL Application tutorial in

Eclipse products.

(232012)
• The definitions for the ASSIGN directive parameters have been corrected in the documentation.

(10604)
• A restriction has been added to the documentation stating that you cannot call COBOL programs

containing COMP-1 or COMP-2 parameters specified BY VALUE, and conversely, you also cannot call
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a C program using a COBOL program containing COMP-1 or COMP-2 parameters specified BY
VALUE.

(8415)
• The documented syntax for CBL_GET_ERROR_INFO has been corrected.

(124059)
• The parameter block for CBL_GET_OS_INFO has been updated. The cblte-osi-rts-

capabilities flag now contains a bit that indicates MFDBFH enablement.

(118068)
• When debugging in the IDE, you cannot extend the length of dynamic-length variables beyond their

current size at the point of execution. Any data beyond the current size is truncated.

(209031)
• The documentation has been updated to clarify that the PREPLIST directive only affects preprocessors.

It will not produce additional content for external compiler modules (ECMs), such as the DB2 ECM. 

01717477 (97172)
• A note has been added to the mftrace.application and mftrace.time CTF documentation

topics to state that these properties cannot be altered once the specified application has been started.

(4881)
• The documentation for the TEXTFILE and BINFILE Emitter properties has been updated to state when

the LOCATION property is used.

(3896)
• The properties for the mf.rts CTF component have been updated/corrected in the documentation.

(195073)
• Additional links have been added to the documentation for 'dynamic length' items, to allow easier

access to all information relating to this subject.

(230024)
• The documentation has been updated to better explain some of the options available when installing the

Micro Focus License Manager.

(97130)
• A note has been added to the documentation to point out that the level numbers used in a segment

layout file do not correspond to the level numbers that are used in the COBOL source (although the
same group structure is maintained).

00778667 (97101)
• The Data File Tools restriction 'National data items are not supported in record or segment layouts' has

been removed from the documentation.

(123088)
• The Large File Support for Fileshare documentation now points you towards the permissible file limits

for indexed files.

(104263)
• The Prerequisites topic in the Scale-Out Performance and Availability Clusters section has been

updated to include the support for Oracle 19c.

02038850 (167027)
• The Application Server JCA support for Enterprise Server topic has been updated to clarify support for

64- vs. 32-bit, and to remove indications of support for Red Hat 6.x EL on UNIX platforms.

(161102)
• The Configuring Security using Active Directory topic contained a broken link to the video covering how

to define an external security manager. This has been fixed.

02004032 (158052)
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• Anonymous binds have been disabled by default on MFDS instances which use "Restrict administration
access". This means that applications such as ESCWA and MFCS which query MFDS Enterprise
Server configuration data will be required to specify some form of credentials based on the MFDS
security configuration. See Class - Enterprise Server Administration in your product Help for more
information.

02209662 (244017)
• Within the documentation, refinements have been made to the tutorial: Developing a PL/I application in

Eclipse.

(236024)
• Slight amendments have been made to the documented Running Unit Tests in the IDE tutorial in Visual

Studio products.

(231022)

Eclipse IDE

Back to the list

• Catalog Explorer filters now persist.

02113386 (191001)
• An issue when opening copybooks using F3 (Go To Definition) has been fixed.

02168679 (216016)
• In Breakpoint view, the line description for COBOL JVM line breakpoints is now displayed.

02163641 (207044)
• Alphanumeric fields that contain a low-values character are no longer truncated when using the

Variables view (or Expressions view) for JVM COBOL.

02159374 (204133)
• An issue when creating a new remote project using a SAMBA connection, through a template, has been

identified and fixed.

02122144 (203185)
• An issue where the incorrect line may be highlighted when debugging COBOL has been fixed.

02173765 (202295)
• An issue has been fixed where copybooks may not have been found during compilation when using

linked folders with Copybook projects projects.

(224013)
• You can now successfully import an enterprise server instance from a path name containing spaces.

(244144)
• An issue has been fixed where 'COPY statement hovers' in the editor were being shown for incorrect

lines.

(209044)
• The Console view in Eclipse no longer hangs.

02085456 (190013)
• A problem where the spool or catalog tables in Eclipse could lock up whilst editing has been resolved.

(186032)
• A fix has been applied for the font used in the Catalog view in Eclipse.

(158058)
• A focus issue has been resolved in both the COBOL and Server explorers, as well as in the context

menu handlers. Previously, consecutive context menu actions in some places would cause context

Resolved Issues | 27



menu to appear empty until refocused; also, the Enterprise Server sub menu on a project in the COBOL
explorer did not seem to do anything.

(167113)
• A restriction has been removed which prevented associating a project with an enterprise server region

through a remote ESCWA and further remote MFDS.

02026484 (162106)
• The generate process for Profiler/Code Analysis set on an enterprise server instance is no longer

performed when the instance is stopped during Eclipse's shutdown process.

(233009)
• You can now enter values larger than 100 in the record length fields when editing data sets in the

Catalog view in Server Explorer.

02099686 (190009)
• A bug in Server Explorer was expecting all servers underneath an mfds to have debug settings, which

is not the case for Fileshare servers. This has been fixed so that all valid servers are shown in both
Server Explorer and the launch configuration.

02155887 (203066)
• The target path for linked folders was not being calculated correctly when determining the output folder

for profiling results. This has been resolved.

(110096)
• There was a bug in the environment variable handling when starting regions from Server Explorer,

which caused existing environments to be overwritten, as well as aborting when comment characters
were encountered. This has been fixed.

02132903 (193080)
• COBCPY was not being constructed correctly when generating IMTK information and when using linked

folders in a copybook project. This has been resolved so that all expected paths are now resolved and
included in the path.

(10252)
• When generating IMTK information, the copy path for the COBOL program was not being correctly

constructed in the case where copybook paths are defined in a dependent project. This has been
resolved.

02104242 (191018)
• The string used for constructing the path to the destination of symbolic links on Windows was not being

processed correctly. This has been resolved so that all target paths of Windows symbolic links are now
resolved correctly.

(62176)
• Remote COBOL Unit Testing projects can now be created using SSH connection types.

02232653 (246125)
• It is now possible to specify input/output parameters with the same name but different direction for 01

level data items. For any other cases on same level, duplicate names are not allowed.

01894253 (124128)
• The error thrown when resolving conflicts in COBOL source files using the Git Merge tool has been

fixed.

02075324 (182051)
• The Perform automatic directives determination preference has changed from a check box to a

group of radio buttons (Always, Never, and Prompt).

(6335)
• When running the client-side connection tests for a remote server connection, the test for the Java

version on the remote host requires a minimum of version 1.8.0.192 in order to pass.
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(226012)
• A new preference page has been added in the Eclipse preferences, which allows you to adjust certain

timeout settings for certain long-running queries executed against a remote EA server. Access the
preference page via Window > Preferences > Micro Focus > COBOL > Code Analysis >
Application Wide Knowledge.

(238015)
• The Determine Directives option is not supported for JVM COBOL projects, and so has been removed

from context menus relating to such projects.

(97069)
• Two new options are available to control the behavior of new dependency/copybook paths, available

from the Preferences pane - Micro Focus > Builder > Project. Select Insert to the beginning of
dependency/copybook paths list or Append to the end of dependency/copybook paths list to
control the initial position of new items added to the list.

02168679 (216017)
• Local enterprise server instances (running on a local MFDS, connected to a local ESCWA) use the

casstart and casstop commands when started/stopped. These commands are run under the local
user's credentials.

02147034 (198054)
• The ESCWA field has been added to the dialog box you must complete when using the Submit JCL to

Enterprise Server context menu option in Eclipse.

(232002)
• The Program breakpoint on main entry point only option has been added to the COBOL Enterprise

Server debug configuration. If selected, a program breakpoint causes execution to stop only when the
Procedure Division entry point is called.

02159204 (203241)
• An enhancement has been made to enable nested rule sets (sub folders) in the XML used for rule set

import.

01947033 (148047)
• When working with Web Services within Eclipse, the Mapping Properties dialog box has been

renamed to the Properties dialog box, and the Mapping Properties tab within this dialog box was also
renamed Exit Point Handler.

(10172)
• The Analysis View page from the Code Analysis preferences has been renamed to Analysis

Results. An additional colorization option has also been added for remote analysis servers.

(233003)

Enterprise Server

Back to the list

• The CPU Warning for a threshold incorrectly calculated that the process was using CPU. This has now
been fixed.

00367274 (26052)
• An RTS 114 resulted when using the MQPUT1 with the ES_MQMONEX exit. This has been fixed.

02026475 (161077)
• In an HSF-enabled enterprise server region, a task that was killed for exceeding a threshold sometimes

caused shared memory corruption if it was purged during a local trace table rollover. This would cause
casmgr to trap and bring down the enterprise server region. This has been fixed.

02133017 (194118)
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• A SEP could stop producing system traces. This has been fixed.

02068443 (195029)
• The list of SOR models was truncated if it exceeded 256 bytes for a given type (TS or TD). Previously,

truncation could occur midway through a prefix, resulting in an incorrect prefix being applied to TS/TD
processing. This has been fixed so that truncation occurs only after the last complete prefix. In addition,
a warning message (CASSI9042W) is sent to the console log. If this message is detected, then the
SOR models need to be reviewed and reduced to less than 256 bytes or, if not possible, then the user
exit TSTDSRUE can be used instead.

(245129)
• A performance improvement has been made so that there is no attempt to access a TSQ during REQID

generation in the START processing triggered by the EZASOKET listener.

(153017)
• A transient SEP in a PAC could hit a runtime error on process shutdown. This has been fixed.

(221080)
• The casmgr could crash after killing a process that exceeded a threshold and the enterprise server

region was configured with a positive dump_limit value. This has been fixed.

(204106)
• When a terminal is installed without a termtype defined, and the netname is already in use, a new

message "CASCL0002S Auto-install error, NETNAME xxxxx already in use" will be written to CSSL.

02166861 (221052)
• When using casout in a PAC, the PACNAME was not added as a prefix to the security call. This has

been fixed.

02008463 (156097)
• A memory corruption when synchronizing a PSOR in shared memory has been fixed.

02211316 (245052)
• If an alias transaction was marked disabled and used in a URIMAP, the transaction was still executed.

This has been fixed.

02180247 (222112)
• The EZASOKET listener will now reject connections when no more sockets are available instead of

terminating and waiting for new sockets to be available to continue working.

02049614 (170013)
• A timing issue that could have resulted in a SEP registered in the dispatch chain even after a

registration error has been fixed.

02176557 (211023)
• An issue where a job could be dispatched after the enterprise server region had started to shutdown

has been fixed.

02103857 (191022)
• Previously a dump of all the SOR stores was taken when a dump command was issued. In future, a

dump of the SOR stores will only occur when a system dump has been requested. This will reduce the
number of dumps generated in the system.

02131841 (193081)
• When using query security for TRANSATTACH the wrong class XPCT was used instead of XTRAN, this

has been fixed.

02198966 (244051)
• In a PAC, if an enterprise server region could not be started and casmgr failed in initialization before

connecting to the PAC, cascd could decrement the number of enterprise server regions contained in
the PAC. This has been fixed.

02055658 (176012)
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• A dead lock could occur if a process had been killed whilst in a third-party program by the threshold
monitor thread. This has been fixed.

02064488 (175076)
• PCT block was not addressed under certain circumstances. This has now been fixed

02202935 (224016)
• If the entry point mapper was used to map MQ calls and the connection had been lost to MQ, a trap in

dfheibmq could occur. This has been fixed.

02082822 (182086)
• When an enterprise server region is running in a PAC, certain locks that were unnecessarily stored in

the database will now be stored in the enterprise server region’s shared memory, improving
performance.

01932670 (146018)
• Values returned in ESCWA/ESMAC for active TRANCLASS could be corrupted if CTF was active. This

has been fixed.

(244052)
• When switching for MIQM from one MQSERVER to another MQSERVER, a network error could be

returned by MQ resulting in an XA error code -5. If this happens the SEP will be recycled as the work
cannot be processed in that state any longer.

02211334 (246063)
• If an error occurs when calling SAFMGR on SEP initialization after the enterprise server region was

started successfully because the LDAP connection was lost,the SEP will now stop but the enterprise
server region will not, and the next SEP will have a chance to reconnect to LDAP.

02031096 (174010)
• If the casout utility times out, it will now close the session enabling another request to reconnect to the

server side.

01994995 (203057)
• If a TCLASS key contained the ‘@’ character then Enterprise Server could not correctly read it. This has

been fixed.

02287206 (260120)
• An issue where the group name specified on the casstart command line was not being passed and

used correctly causing the region to not stay up has been fixed. The condition was that the default
group associated with the user did not have permissions to start the region (OPERCMDS casstart).

02163023 (245046)
• In a PAC setup, ENQ's on the pipeline and webservice resources are no longer stored in the DB. They

are stored in SHM.

00775012 (91020)
• An issue with EXEC CICS DELAY API when compiling with DIALECT(OSVS) has been fixed.

02206914 (236048)
• The TABLE resource under MFESMAC now controls whether the user can modify the services in

ESMAC or ESCWA.

02131841 (194095)
• Security checks were being performed against an incorrect resource when cataloged datasets were

accessed using the data file editor. This has been fixed.

02160499 (203144)
• A mutex was taken too early resulting in a serialization of work been processed when a terminal

disconnect was issued. This has now been fixed.

02068931 (181001)
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• A link to a remote PPT was not correctly removing the PPT from the PAC resulting in a subsequent
inquire to find the PPT local. This has been fixed.

02206930 (235037)
• An issue where enterprise server regions did not start with the COBOL Server or Development Hub

products has been fixed.

(199060)
• Improve performance by opening spool files once at the start of the process and not open/close for

each request.

01994995 (194119)
• Custom HSF fields now correctly handle the maximum data length of 255 characters.

(5794)
• In ESMAC, a Cross-Site Scripting (XSS) vulnerability has been fixed.

00376857 (104212)
• The very first record written by an initialized SEP to an extended variable length ESDS file gave an error

of EIBRESP2=110 with EIBRESP=0. This has been fixed.

00367116 (86028)
• When using the Micro Focus External Call Interface (ECI) over TCP/IP, the request and response data

flows are now compressed using RLE.

3207572 (13314)
• Under some conditions, when a security look up failed the administrative LISTRESOURCE request

would be driven. If the target class contained a significant number of members, the time taken to
complete this could impact performance. A change in the ESM interface means the LISTRESOURCE
request is no longer being executed.

00748245 (88213)
• When a LINK explicitly or implicitly specifying a remote transaction ID, EIBTRNID would be incorrectly

populated with the target transid. This has been fixed.

02250109 (252012)
• When performing a dynamic remote LINK; that is, when using the SYSID option a PPT entry was being

erroneously created in the local enterprise server region. This has been fixed.

02156790 (203165)
• When starting a debug session, particularly when remote, an internal shared memory lock would result

in the enterprise server region becoming unresponsive until the session was established. This has been
fixed.

02158284 02177256 (203215)
• Enterprise Server now appropriately populates the entity name when validating remote file access for

mfDataTools2.

02111703 (191045)
• CASCD will no longer clear all remaining locks in the region database if it is being shut down while in

quiesce mode.

(185025)
• A buffer insertion logic error resulting in a truncated Enterprise Server Environment has been fixed.

01920281 (142016)
• The ESMAC HTTP status codes have been updated to be more appropriate for certain errors.

(202271)
• Enterprise Server will no longer perform a recursive call while waiting for a TRANCLASS dispatch in a

PAC.

02168754 (204246)
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• The THRESHOLD CICS resource and its attributes are now prefixed by an underscore when exported
with casrdtex as they are Micro Focus specific. The casrdtup import utility now also requires this
underscore.

(245063)
• Parameters given to mfconfigmanagerapi calls were misaligned. The API was also using an

incompatible library causing exception handling to fail when attempting to read the definition file. This
has been fixed.

(194046)
• Dynamic debugging port operations are now under a Mutex.

02155297 (203227)
• Fixed an issue with the display of RTS error messages in the console.log file.

01838001 (116004)
• An issue where a SEP did not recycle on xa-start failure has been fixed.

01839273 (112032)
• The new user exit BKAUXTRC has been added. The BKAUXTRC exit will be called when a trace switch

occurs in an enterprise server region. The current aux trace will be closed and renamed to .bkp and
the BKAUXTRC exit is then called to archive the file so that trace is not lost in a busy system. See Exit
When a Trace Switch Occurs in an Enterprise Server Region in your product Help for more information.

(162021)
• A new RemShrQueues action has been added to the caspac utility. This option enables you to delete

all stores called Shared_CasTSQ_RC, Shared_CasTSQ_NR, Shared_CasTDQ_RC, and
Shared_CasTDQ_NR. See caspac in your product Help for more information.

(217010)
• In ESCWA, a new option has been added to the ES Control page to enable CTF to be dynamically

enabled/disabled on a started enterprise server region. See ES Control in your product Help for more
information.

01926245 (142040)
• A new caspac action, RemOldPAC, has been added to enable the removal of old PAC stores not

prefixed. See caspac in your product Help for more information.

(252007)
• You can now use the caslock command to view a list of locks for enterprise server regions that are

members of a PAC. See Lock Processing in your product Help for more information.

Note: You cannot use caslock to remove locks in a PAC.

02205807 (236041)
• The HTML document lang attribute now changes when the language of the ESCWA application

changes.

02010059 (156074)
• In ESCWA, removing a dynamic debugging session was incorrectly returned from the API request. This

resulted in a "Request Failed: Unexpected error processing request" message on the dynamic
debugging request page in the UI. This has been fixed.

02135527 (193107)
• The ESCWA UI files are now included in Solaris builds.

(103080)
• An issue with ESCWA encoding when operating with SJIS encoding has been fixed.

02157606 (204076)
• The ESCWA Client Web API documentation has been corrected for two endpoints:/native/v1/regions/

{host}/{port}/{region}/enqmodel/view/{resource}/discardhas been corrected to:/native/v1/regions/{host}/

Resolved Issues | 33



{port}/{region}/enqmodel/view/{resource}/uninstallIn addition:/native/v1/regions/{host}/{port}/{region}/
tsmodel/view/{resource}/discardhas been corrected to:/native/v1/regions/{host}/{port}/{region}/tsmodel/
view/{resource}/uninstall

(259031)
• The MfRequestedEndpoint value in the ESCWA configuration file (typically commonwebadmin.json)

was being set to an invalid endpoint. When the ESCWA server starts, it uses this value as the endpoint
for it to start on; if it is invalid, the ESCWA server would error and fail to start. This issue has been fixed
by added server-side validation for the MfRequestedEndpoint field: the value must be in the format
protocol:host:port; protocol must be "tcp" or "tcpssl"; host must be a valid hostname, IPv4, or IPv6
address, or "*". The port must be a valid port number or "*". Any request attempting to set
MfRequestedEndpoint to a value that does not meet these validation requirements is rejected with a
400 "Bad Request" HTTP error. If the ESCWA configuration file has already been set to an
MfRequestedEndpoint value, the ESCWA server will still fail to start, but will now output a more specific
error message. In this case, the issue can be resolved by either manually editing the
MfRequestedEndpoint value in the ESCWA configuration file, or by starting the ESCWA server with the
following command line options:BasicConfig.MfRequestedEndpoint=tcp:localhost:10086 --
write=trueReplacing "tcp:localhost:10086" with the required endpoint.

01983736 (148074)
• Timeouts and performance issues on initially loading the spool table have been mitigated by preventing

the spool table from sending an automatic request upon visiting or reloading the page. The "List" button
now needs to be pressed to trigger the load or to apply a filter. This enables you to avoiding
unnecessary requests that might timeout.

02152418 (203033)
• The ESCWA server now has improved handling of unexpected and unsupported properties in the

configuration (commonwebadmin.json by default). An unsupported property in the default configuration
file will result in the ESCWA server logging a warning, removing the property in question, and
continuing. If an unsupported property is found and the configuration has been supplied or overridden
using command line arguments, the ESCWA server will log an error and exit. This behavior can be
controlled using the new --strict-config command line argument.

(143008)
• Safety checks for POST/PUT requests with empty bodies have been improved.

(178001)
• Improved usability of IMS API endpoints by expanding property descriptions in schemas to incorporate

relevant sections and labelling from the product documentation. The improvements will enable you
correlate API to relevant UI functionality, and to discern the purpose and relevance of schema
properties in an endpoint from reading the descriptions.

00372390 (24044)
• The browser title is now set to the name of the selected enterprise server region.

00748187 (90012)
• In ESCWA, you can now download the information you can display on the JES Catalog Entry and Spool

Job Output pages. The download functionality retrieves the values starting from page 1 and is not
restricted to a page limit. Note: The download will use the Codeset and Details values as set on the
page.

00366654 (12735)
• Issue where table row buttons could be moved past the right edge of the table and made inaccessible

has been fixed. In addition, the cosmetic bug where table row separators and row highlighting did not
extend to the right edge of the table in some circumstances has been fixed.

(237046)
• In ESCWA, to switch users you now need to logoff and then log back in using the appropriate

credentials.

(101032)
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• In ESCWA, incorrect instances of "Job Control Table" have been corrected to "Journal Control Table".

(87028)
• The spool table now caches the results of the last query executed and persists those results between

pages, preventing the query from being unnecessarily rerun.

02198043 (221138)
• In ESCWA on the JES Catalog page, the RECFM list now has the VBS option.

00777434 (91091)
• In ESCWA, the catalog table now displays the error or information message when ESMAC would have

display one, including when accessing a corrupt CATALOG.

00779645 (97184)
• There is no longer an issue with incorrect error/success messages when deleting a dataset without

relevant permissions in ESCWA. In this case, ESCWA now correctly handles the response from
ESMAC.

01810271 (123009)
• In ESCWA, modifying the SOR Connection Path(s) field in the Scale-Out Repository Configuration

dialog box  did not update the SOR connection information. This has been fixed.

01907342 (127044)
• In ESCWA, you can now resize the columns for the Spool table.

02022132 (162025)
• Errors in the ESAdminAPI.yaml file have been fixed.

(124111)
• In ESCWA, while submitting JCL through the browser, special characters are now correctly preserved.

(91119)
• The issue where the Apply button was left disabled when changing values on a Communications

Process page has been fixed. The 'Client CA Root Certificates File' field is now correctly disabled when
'TLS Enabled' is unchecked. This will not have affected Communications Processes that had 'Client
Authentication' set to "Accept all clients" before unchecking 'TLS Enabled' as the 'Client CA Root
Certificates File' is removed under that condition.

02183154 (222089)
• In ESCWA, the Spool page no longer uses deprecated ESCWA API.

(71382)
• In ESCWA, the services table now auto resizes correctly when expanding tree elements.

(99075)
• In ESCWA on the Services page, the name fields in the Service table rows are now aligned correctly.

(62209)
• In ESCWA on the Monitor page, the graph now displays Milliseconds on the left y-axis label when it is

set to display milliseconds.

(57469)
• In ESCWA, URIMAP creation is now possible when Usage is set to Pipeline. Previously, an issue with

the field validation incorrectly set the form to be in an error state when Usage is set to Pipeline, which
disabled the Save/Apply button; the validation logic has been corrected.

01858819 (118078)
• In ESCWA, the Monitor Control page has been fixed for an enterprise server region.

(203107)
• In ESCWA, error messages can now be read by the screen reader.

01995465 (162038)
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• In ESCWA, the keyboard navigation of the add widget's dialog has been improved.

02010047 (157066)
• The ESCWA UI has been re-themed to conform to Micro Focus standards. This changes the font, and

uses title case where appropriate along with many other style and color changes.

01995207 (157061)
• In ESCWA, the keyboard navigation of the tree has been improved.

02010055 (156075)
• ESCWA now supports various accessibility technologies including text-to-speech voice readers and full

keyboard-only navigation.

01995445 (163045)
• A redundant error message, triggered when shutting down ESCWA, has been removed.

00370913 (126001)
• ESCWA better reflects the status of enterprise server processes in error cases when starting and

shutdown.

02229975 (246126)
• ESCWA abended when an empty body was sent in a PUT or POST request. This has been fixed.

(175064)
• An error occurred in ESCWA when trying to log on to an enterprise server region when already logged

on. This has been fixed.

(231033)
• In ESCWA, keyboard navigation issues with tree controls have been fixed.

01995458 (157059)
• The German translation for ESCWA has been updated.

(181003)
• The Content Security Policy HTTP headers on ESCWA has been improved.

(71455)
• In ESCWA, once modifications for a security group had been saved you could not make subsequent

saves till the page was refreshed. This has been fixed.

(138140)
• When creating an ESM user, specifying a group did not add them to that group. This has been fixed.

(143028)
• In ESCWA, the display of region trace has been fixed.

(221090)
• ESCWA will now display transient SEPs on the SEP List Page.

(198051)
• The occasional "Unable to locate translation string!" messages from ESCWA Server on AIX were

incorrectly displayed. This has been fixed.

(151015)
• The URIMap Cipher field's validation now account for xml files as permitted input.

(107003)
• In ESMAC, a new option has been added to the Control page to enable CTF to be dynamically

enabled/disabled on a started enterprise server region. See Control in your product Help for more
information.

(146114)
• ESCWA now supports displaying Queued Requests by TRANCLASS when the enterprise server region

is a member of a PAC.
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(189004)
• In ESCWA on the Control page, a warning has been added above the Dynamic CTF File Location

field and to the API documentation informing you to set the CTF Action field to All Off before
changing the Dynamic CTF File Location field or the file being referenced.

(244057)
• In ESCWA, check mfcm on the ES Control page to trace the Configuration Manager. See ES Control

in your product Help for more information.

(220010)
• The Enterprise Server Administration Configuration dialog now has an External Communications

Response Timeout number picker, which is used to set the timeout for ESCWA requests that go
through MFCC. This timeout is equivalent to setting the MFC_TIMEOUT environment variable, but is
only applied on a per-request basis rather than an environment-level setting.

00502152 (76011)
• In ESCWA, on the Monitor page the graph's x-axis has been corrected to display time in order from

oldest to latest from left to right.

(158066)
• UDP sockets are now closed when not required by MFDS communications.

02181946 02193815 (222040)
• An issue with newly created Communications Processes being set to the started state but not actually

being started has been fixed.

(88221)
• Mfsecrets would intermittently crash on HP UNIX when certain messages were loaded. This has

been fixed.

(106063)
• The mfsecretsadmin utility no longer displays spurious allocation errors on AIX PPC.

(105093)
• When using MFSecretsAPI with the HashiCorp provider on a Solaris SPARC platform you will no

longer get an error for referenced symbol not found.

(103082)
• The mfsecretsadmin error callback formatting has changed to improve readability and remove

unnecessary information.

(8552)
• Secrets written from now on are transferable across platforms with different endianisms.

(104103)
• In the ESMSSQL switch, version 17 calls to SQLSetConnectAttr now check both the sqlrtn code

value and the status item of the XACallParam.

(110060)
• An extraneous MQ rollback for TM processes has been fixed.

(231005)
• The DB2 switch module now provides more traces regarding CLI failures.

02202803 (239025)
• XA switches now contain logic to trace XID in the Consolidated Trace Facility (CTF).

01965103 02055821 (162072)
• The logic to parse the Open String option ESLOGGING now works correctly.

02172047 (208024)
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• The Oracle switch source now has the correct data alignment to prevent RTS 114 error when more than
one Oracle XARs are specified in the enterprise server region.

01802747 (103172)
• When using ESF in Redundant mode and having multiple ESM in the relevant Security Manager List,

even though a request was successfully handled by one of the first ESM, an event failure would be
returned if the last ESM in the list reported a failure. This has now been fixed so that if the request is
successfully handled by any ESM in the list then the last ESM will not return its failure status, instead it
will be logged.

00372409 (11512)
• The MLDAP ESM, OS ESM, and PAM ESM modules now use the RACF password alphabet for

encoding short passtokens rather than the base64 alphabet.

02168078 (202221)
• The esfadmin utility is now delivered in 32 and 64-bit versions.

02182768 (218011)
• The caching mechanism of Enterprise Server's External Security Facility (ESF) is now able to cache

some requests it previously could not, such as Verify (signon) requests with long usernames or
passwords, and Auth requests for some MQ-related resources. These changes make cache records
somewhat larger, so fewer will fit in a cache of a given size. If you are using ESF caching you might
want to increase the size of your cache by 20% to 40% to account for this change if you observe a
decrease in the cache hit rate reported at enterprise server region shutdown.

02154022 (203072)
• In some configurations, Enterprise Server security could lose track of users' group membership

information in a running region or instance of MFDS after an ESF Update request. This has been fixed.

00741997 02182494 (86057)
• The validation of server certificates for SSL/TLS connections in the Micro Focus Common Client has

been improved. Specifically the standard PKIX (Public Key Infrastructure, X.509) rules are now followed
except when connecting to the server using information obtained from the Micro Focus Directory Server
(MFDS), if that information only contains an IP address and not a host name. In earlier product releases
MFCC did not enforce PKIX when using information from MFDS regardless of whether the information
included a hostname.

(52097)
• An invalid invocation of the SAFROUTE API under certain non-default configurations could cause a

divide-by-zero trap. This has been fixed.

02016793 (163052)
• The performance of the optional "prefix search optimization" feature of the MLDAP ESM Module has

been improved.

00726158 (142020)
• The External Security Facility can now optionally update the "short name" of signed-on users. See

Renaming ACEEs in your product Help for more information.

00657507 (70355)
• HSF statistics for some hexadecimal TS/TD queue names could be incorrectly reported. This has been

fixed.

(146013)
• HSF records would be missing when the task number rolled over from 99999. This has been fixed.

02026013 (165049)
• HSF records for transactions that were killed due to having exceeded a threshold would sometimes

have a response time of 0. This has been fixed.

01687237 01817975 (97116)
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• When the casmgr process was recovering locks in mfdbfh, it was holding the shared memory lock.
While recovery was in progress, no other processes in the enterprise server region was able to access
shared memory. This was unnecessary and casmgr now releases the lock before initiating the
recovery.

02088479 02086462 02085808 (185024)
• A memory corruption that could occur when the monitor thread killed a process under heavy load has

been fixed.

02006375 (158087)
• New messages have been added to the console.log for startup sequences in order to be able to

troubleshoot enterprise server region startup issues.

01935739 (138172)
• If a TSQ in the SOR contained a space x'20' in the name, then the delete of the queue failed. This is

now fixed.

01829779 (182032)
• An RTS 173 occurred on an ES_mF_write_record_in_store entry point when an enterprise server

region was not in a PAC and SSTM was used. This has been fixed.

01806033 (103156)
• If a transaction executing in a PAC environment with TRANCLASS max priority active was killed by the

threshold mechanism, a hang could result on subsequent transactions executing in the same class due
to the counter not being decremented. This has now been fixed.

02168754 (209029)
• An RTS 114 occurred when a transaction had a TRANCLASS defined and the purge threshold was

reached. This has been fixed.

02144961 (204147)
• MFDBFH connections are now closed when a task is idle.

01984788 (150015)
• Enterprise Server now handles bundle manifest files that can contain multiple JSON transform

resources.

01991361 (150057)
• Latency for queued transactions in a TRANCLASS was attributed to their response times, not latency.

The latency is now correctly displayed in the latency field.

02176385 (209033)
• SCB was not being freed after normal shutdown of a transient SEP. Behavior modified to free the SCB

after this occurs to avoid issues when a SEP with the same PID is launched.

02190327 (220061)
• Loading and calling the single-threaded version of support modules within a multi-threaded process was

resulting in a hang. This has been fixed.

00779469 (92169)
• An issue with parallel one and two-phase XA connections has been fixed.

00700923 (73098)
• The XA recovery processing now supports a retry mechanism:

 ES_XA_RECONNECT=Y,delay,retry_count

Where retry_count is the number of recovery retry attempts to be made if the XA verbs return an xa-
retry (04) return code. In this case, messages are sent to the console. See Environment variables
in alphabetical order in your product Help for more information.

02157658 (203087)
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• The command-line utility caspac, now has the RecoverUUID action that enables you to specify the
UUID of an enterprise server region that has left the PAC. The action will remove all entries related to
that enterprise server region from the PSOR. See caspac in your product Help for more information.

(185013)
• The casToken and csrf-token security has been increased by increasing the token regeneration

frequency.

00368452 (12551)
• The performance of the ESCWA Spool View has been improved when using a database hosted catalog

file and when specifying a filter with a leading wildcard character.

01856008 (138119)
• An issue with the format of messages caused ESCWA to report success as a failure. This has been

fixed.

(125020)
• The "job user" filter string entered in ESCWA or ESMAC were being folded to upper case and

sometimes resulted in records not being displayed. This has been fixed.

00469828 (57335)
• Missing JSON properties have been added to the ESCWA active PCT API.

(222149)
• Character validation for HTTP cookie values in secure regions has been added.

02132269 (202051)
• The fix for OpenSSL Denial-of-Service (DoS) issue CVE-2022-0778 has been applied to the product.

(221130)
• When Enterprise Server's MLDAP ESM Module is used for security, with Micro Focus password hashes

and password history enabled, history entries are now created with the correct type of hash (Argon2 by
default).

(120086)
• In Enterprise Server, when using LDAP-based security, all-groups mode, and username mapping ("long

names"), if a user's group membership was changed and the esfupdate utility was invoked with the
user option to update information in the region for that user only, the user's new group membership is
now calculated correctly. Previously some of the user's groups might have been missed when
determining the set of groups.

(98040)
• For LDAP-based security with Enterprise Server, a new configuration option (password change failure)

determines whether a failed attempt to change a password causes signon to fail. See MLDAP ESM
Module Custom Configuration Information in your product Help for more information.

00736902 (99142)
• When a PAC uses Enterprise Redis, set up a custom hashing policy using the following rules:

• Rule 1: .*?\{(?<tag>.*?)\}.*
• Rule 2: (?<tag>.*)

01872664 (152015)

File Handling

Back to the list

• The mfdbcatc utility sometimes lost a directory element in a path when expanding an environment-
based pathname. This is now resolved.

00707621 (69585)
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• In response to a SORT215E error, an identifier has been included to locate the fail position when the
reformatting error occurs; also, some OUTFIL variables are initialized.

01832594 (119050)
• The maximum line length of fhredir.cfg has been increased to allow for the full MFPORT/MFNODE

to be set.

01971422 01970683 (138292)
• An issue with Fileshare performance has now been resolved.

(70294)
• An issue when trying to run Fileshare in background mode has been fixed.

(101104)
• An error where incorrect results may have been returned when a READ on an alternate index was

attempted without first performing a START has now been fixed.

(138152)
• Temporary files should now be created correctly in the Data File editor when connecting to a remote file.

(92087)
• WRITE operations to variable-length output pipes are no longer being treated as fixed-record-length

WRITE operations; previously, the variable length set by a program was being ignored.

02183108 (220017)

Interface Mapping Toolkit

Back to the list

• The HWTJGTST API now returns a correct value in the JSONType parameter when invoked with the
objOrEntryValueHandle parameter set to a value of null, indicating the top of the JSON tree being
parsed.

02102661 (220107)
• COBOL clients no longer have duplicate data names in certain scenarios when the WSDL or JSON field

name is greater than 30 characters.

01815167 (111010)
• COBOL client data items now have the correct size for JSON fields with "int64" format.

01815173 (104242)

Micro Focus Common Client

Back to the list

• The Micro Focus Common Client (used by COBOL web-service proxy programs) now supports the
"gzip" content-encoding for HTTP messages. MFCC recognizes gzip'd response and request
messages, respectively.

00370460 01901934 (12322)
• A 114 Attempt to access item beyond bounds of memory (Signal 11) no longer occurs during FST101A

test.

(231036)

Micro Focus Directory Server

Back to the list

• The MFDS TLS redirect code has been hardened to improve security.

01938276 02124054 02232906 (157050)
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• HPUX snprintf caused TLS redirects to fail. This has been fixed.

(216005)
• If a shortened hostname fails to resolve, then resolution of the full hostname is attempted.

02207755 (240012)
• If there is a problem resolving the machine local hostname the MFDS process will display the following

startup failure message rather than a "Bind fail=136" message:"CCITCP2-0252E hostname resolution
error."

(221047)
• On import of an MFDS repository, some configuration types (such as XRM and MQ Listener) were

double-counted, which could result in the configured object limit being breached even though the
number of imported items did not exceed it.

(202284)
• The status of whether the vault is enabled and in use by the MFDS process was not displayed in the

MFDS Web user interface as it was in Visual COBOL and Enterprise Developer 5.0. This has been
fixed.

(217031)
• The MFDS process could hang if too many enterprise server regions were defined and started. This

has been fixed.

02190282 (222092)
• MPR PWFI support has been added to MFDS via the mfIMSMPRPWFIDispatch MLDAP API MPR

property.

(80014)
• In ESCWA, an error would occur when trying to modify a listener on a communications server other

than the first. This has been fixed.

02191654 (222078)
• There is no longer a long delay when attempting to shut down an enterprise server region that is

retrying an ISC connection.

01689657 OCTCR50A193010 OCTCR50A181100 (101059)

Micro Focus License Administration

Back to the list

• In a system where many licensed processes are attempting to get responses from the mfcesd daemon,
it is possible for the underlying system kernel to constrain resources used by the UNIX domain sockets.
This can cause the send response to fail with a resource unavailable temporarily error. This caused the
ces daemon to lose its contact with the requesting client, resulting in a hung client process.

The CES daemon now recognizes this temporary constraint condition and throttles the connection
slightly and retries. The daemon now always sends a response to the client process.

Micro Focus recommends that you also tune the kernel parameters shown below to allow more
resources for a heavily used system, to prevent the underlying condition.

The following examples show the parameters to change and show very high values. Micro Focus
recommends that a network expert or an administrator reviews these values and adjusts them to
achieve a sensible balance:

# Increase number of incoming connections

net.core.somaxconn = 65535

# Increase number of incoming connections backlog

net.core.netdev_max_backlog = 65535
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02196423 (245004)
• Before performing a Repair of the Visual COBOL installer, Micro Focus recommends that you create

backups of any configuration files of the product that you might have changed.

02084082 (227001)

Micro Focus Support

Back to the list

• The mfpoll.txt file now includes a new section that has information about whether the machine the
mfsupport script is running on is a Virtual Machine or a physical one.

00466174 (59146)

Panels

Back to the list

• Windows 10 Console Windows resizing has different behavior than some previous releases where the
screen buffer size was constantly resized. Some applications, such as a COBOL Accept/Display
applications, depend on this behavior, which uses a fixed line and column format. To work around this
problem, enable legacy mode in the Console's properties. This disables automatic window resizing. If
legacy mode is not enabled, the screen buffer resize event is captured and the window is resized back
to the original size, which causes some flickering.

02179388 (212008)

Run-time System

Back to the list

• The correct set of synchronization routines using semaphores are now defined in $COBDIR/cpylib/
cblproto.cpy and $COBDIR/include/cblproto.h.

(166016)
• There was an issue in the internal logic of the cobutf8 utility, which could have resulted in a hang

when a very large amount of data was converted to the application's input and the application was
unable to process the data quickly enough. This has now been fixed.

02115599 (190051)
• Timeouts larger than 35 minutes are now permitted with the use of CBL_SEMAPHORE_ACQUIRE, for

32-bit UNIX applications.

02168295 (220103)
• On Solaris platforms, the escwa32 command now starts ESCWA, as expected.

(104059)
• If a shared object was created with cob -z -d symbol_name -l shared_library, where

symbol_name is resolved in the shared library linked into the shared object, then a potential SIGSEGV
sometimes occurred when the shared object was unloaded. This has been resolved.

01848664 (118012)
• The Consolidated Tracing Facility (CTF) is now better protected when the process is processing

asynchronous signals on UNIX.

(218021)
• Issues relating to MFDBFH after a recoverable error that occurs in Enterprise Server have been

resolved.

(97119)
• The -U option of the Micro Focus Configuration Utility for the Microsoft Build Tools and SDK (command

name: cblms) now works correctly if it specifies both a path and a version.
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(86023)
• A memory stomp, which was caused by text wrapping code when multi-byte characters were used, has

been fixed.

02175685 (208014)
• A memory leak caused by alias symbols has been resolved.

01912000 (146043)
• Code has been removed that assumed that Disk space exhausted was the only failure mode for a

disk write operation. It has been replaced with a query of errno when a write operation fails to output
the expected number of bytes (so the run-time system now copes as well as the operating system
does). 

01978959 (195086)
• Previously, it was not possible to use the old Microsoft bitmap fonts such as Courier, MS Serif and MS

Sans Serif with the PC_PRINTER_SET_FONT library routine. This has now been corrected.

Note: Helvetica and Times fonts are no longer available on Windows, and Arial and Times New
Roman fonts should be used instead.

02011925 (160003)
• The cobfile utility it is not supported for Docker images that do not contain the file command. See

your Development Hub product Help for more information.

(221036)
• When using the PC_PRINTER_DRAW_RECTANGLE library routine, if box-style is set to 1 (filled),

and no pen has been set using PC_PRINTER_SET_PEN, the rectangle fill will be solid black.

(127027)

Setup

Back to the list

• Before installing the 8.0 version of COBOL Server, COBOL Server 64-bit, Visual COBOL Build Tools, or
Visual COBOL Build Tools 64-bit, you must uninstall the corresponding 7.0 product.

(258023)
• This release no longer requires Microsoft's Visual C++ 2013 redistributable.

00486278 (71117)

SQL: COBSQL

Back to the list

• COBSQL now exits when the CA-DB precompiler is specified but not installed.

(9638)
• The SQLBGP option has been added to the IDE.

(138181)
• The COBSQL preprocessor has been modified to insert Procedure Division Initialization logic after each

ENTRY statement.

01780938 (118075)

SQL: DB2 ECM

Back to the list

• A new exit for ESXACUSTOMEXT has been added to the DB2 switch module. The build scripts have also
been updated with some new options to enable this logic.
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01688275 (104007)
• For custom exits, the XA-inquiry block must now be specified in the LINKAGE SECTION in the custom

exit sources.

02170335 (204264)
• A problem with compiling VARCHAR or LONG VARCHAR arrays in a COBOL SQL program sometimes

has been resolved.

02105414 (152006)
• A COBOLprogram using EXEC SQL INSERT or FETCH statements without a FOR N ROWS clause

with arrays caused compiler errors. This has been resolved.

(155003)

SQL: OpenESQL

Back to the list

• A problem that prevented the ESMSSQL switch from detecting when the PIP1 transaction is occurring
caused setCurrentConnection to be performed on the incorrect connection. This has been fixed.

01916096 (142006)
• OpenESQL has been modified to process RELEASE TO SAVEPOINT statements in RDBMSs.

00370819 (13104)
• A problem that caused the OpenESQL native runtime to incorrectly handle WITH HOLD FOR UPDATE

cursor against Oracle in 64-bit has been fixed.

00745593 (121047)
• OpenESQL now supports a SYNC clause specified in a variable-length host variable declaration.

02169632 (204218)
• A problem that prevented a properly executed EXEC SQL statement from returning the correct

RETURN-CODE has been fixed.

02036138 (167041)
• A problem that caused the OpenESQL runtime to incorrectly handle SQLDA when the .NET SQL

application used the ODBC driver has been fixed.

01993609 (158003)
• A problem that sometimes prevented an XA connection used with dynamic registration from working

properly with MFDBFH with has been fixed.

00779680 (146073)
• A problem with compiling an EXEC SQL statement of DECLARE CURSOR in which CTE starts with

SELECT * has been resolved.

01798310 (105107)
• A problem that occurred when using CTE in SELECT INTO statement has been corrected.

02117758 (194003)
• When an error occurs, the get error loop now exits if the last error message retrieved is the same as the

current one.

02172041 (209005)

Visual Studio Code

Back to the list

• You no longer receive a Null Reference exception when running MicroFocus.VSCodeJIT.exe /r
on machines that do not have Visual COBOL or Enterprise Developer for Visual Studio installed.

01855303 (120034)
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Visual Studio IDE

Back to the list

• There is no longer an issue with setting the source format to Fixed for .NET COBOL Core and .NET
COBOL Standard projects.

01763326 (104079)
• Right-clicking on an element in a group item or table in the Watch window in Visual Studio no longer

results in an error.

(158134)
• The Windows system folder is now excluded from build dependency checking. This is to avoid full

rebuilds from occurring when building projects after you have installed any Windows updates.

02173365 (222086)
• A performance issue when stepping through native code in the debugger when the memory window is

visible and showing an invalid address has been resolved.  

(182090)
• The console log for an enterprise server was not displayed correctly in Visual Studio when the server

was started using different credentials, for example from the Enterprise Server Common Web
Administration.

(236006)
• Dialog boxes displayed when using menu options in the Micro Focus Servers nodes in Server

Explorer now display correctly when the environment font used by Visual Studio is changed.

(167021)
• The code analysis results highlighting is now shown in the correct position within source lines that

contain tabs.

(91125)
• If the Determine Directives command cannot identify the dialect for a source file, any file-level dialect

override for that file is preserved.

02191877 (246123)
• The CoreDump profile for native COBOL projects now correctly launches the selected core file.

(124048)
• An issue with the case sensitive string check when attempting to launch an "Executable" debug profile

of a .NET COBOL project has been resolved.

01906352 (132008)
• When debugging through .NET Code, an Edit and Continue dialog box could appear that never

completed and could not be cancelled requiring the Visual Studio process to be terminated. This has
been fixed.

(158107)
• You can now select multiple test cases (using the usual Ctrl and Shift techniques) and click Run

Selected to perform a test run of specific test cases.

Note: This option is not supported for individual data-driven test cases.

(6435)
• The Auto-generate binding redirects project property is now supported for .NET Framework

applications

01850991 (131016)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Defect number (in parentheses).

• 02150403 (203019)
• 02091353 (187001)
• 02121754 (202065)
• 02132897 02164401 (198046)
• 01995392 (158073)
• 02010044 (157065)
• 2836772 (7336)
• 02293789 (226006)
• 01912000 (142033)
• 01834420 (98086)
• 00620699 (71289)
• 01811748 (124010)
• 02135207 (193101)
• 02051091 (175018)
• 00725550 (92178)
• 01839124 02145513 (112009)
• 02045736 (166043)
• 01947033 (146111)
• 01994995 (195081)
• 02033743 (161099)
• 02110007 (191044)
• 02289051 (258146)
• 01794492 (105047)
• 00430214 (58005)
• 02254118 (253027)
• 02016027 (163039)
• 00367290 (31077)
• 01862519 (118040)
• 3188835 (11348)
• 00365049 (13049)
• 02161981 (204198)
• (259026)
• 00775199 (218016)
• (259059)
• (244058)
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Unsupported or Deprecated Functionality
This section includes information about features or functionality that are not supported.

• The SafeNet Sentinel licensing system has been deprecated and will be not available in this product
starting with the next major release after release 9.0. The SafeNet Sentinel licenses will not be
supported after release 9.0 and you need to use AutoPass licenses if you use these releases.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
Contact Micro Focus Customer Care for further information.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

System Requirements

System Requirements for Visual COBOL for Visual Studio

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.

The maximum disk space requirements are, approximately:

Visual COBOL Sentinel RMS License Manager

1.2Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Note:

• A 64-bit Windows is required. You can produce both 32-bit and 64-bit applications with Visual
COBOL installed on a 64-bit operating system.
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Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components. A supported version of Microsoft's Visual Studio must
be installed in advance.

Besides the software listed below, the setup file also installs the 64-bit AdoptOpenJDK 11.0.8 (LTS) with
Hotspot.

This product includes OpenSSL version 1.1.1n-mf6 (modified).

• Visual Studio IDE
• Selecting the Visual Studio components to install
• Installing Visual Studio features that are not currently installed
• License Manager requirements
• Other Requirements

Visual Studio IDE

You must have Microsoft's Visual Studio 2017 version 15.9 or a newer one, or 2019 version 16.11 or a
newer one, or 2022 version 17.0 or a newer one installed in advance. SQL CLR in Visual Studio 2022
requires version 17.1 or newer.

Note: Problems with Microsoft's Visual Studio 2022, release 17.2, might cause issues with some of
the functionality in Visual COBOL for Visual Studio 2022. See Known Issues for details.

You need one of the advanced versions of Visual Studio listed below:

Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.
Professional, Enterprise or Community Edition (for Visual Studio 2019) - see the next section for the
Visual Studio components you must install.
Professional, Enterprise or Community Edition (for Visual Studio 2022) - see the next section for the
Visual Studio components you must install.

Microsoft's Visual Studio Express Edition is not supported.

Important:

• When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Visual COBOL product help inside Visual Studio. When you select components to
install in the Visual Studio installer, click Individual components and check Help Viewer in the
Code tools section.

The following software is also required:

• Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Selecting the Visual Studio components to install

The Visual Studio installer enables you to customize and only install the workloads and components that
are most suitable for your area of development. For example, you can select the components that are
required for .NET desktop development, ASP.NET Web or C++ development.

If not already installed, the Visual COBOL setup file will install the following components:

• .NET Framework version 4.7.2.
• Debugger
• Data services

A number of workloads and components are optional and only required by specific types of applications or
tasks:
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• Azure, WCF, Web, WPF or SQL CLR application development.

If you require any of these, you can select them when you start the Visual Studio installer or, enable them
after completing the installation - see the next section.

Installing Visual Studio features that are not currently installed

If a feature of Visual Studio was not installed during the Visual Studio installation, the respective
functionality or the project templates for it are not available. You can install a missing feature in one of the
following ways:

Rerun the Visual Studio installer:

1. Start the Visual Studio installer and choose to modify an existing Visual Studio instance.
2. Select the workloads and the components that are missing (for example, ASP.NET and web

development or Help Viewer).
3. Start the Visual Studio installation.

Use the Quick Launch control in Visual Studio:

1. Start Visual Studio.
2. Type the name of the feature in the Quick Launch control - for example, type ASP.NET or Help

Viewer.

A drop-down list with any features matching your search string appears. If the feature is not already
installed, one of the search results will be an option to install it.

Use the Install Missing Feature(s) command in Visual Studio:

1. Start Visual Studio.
2. Click Help > Micro Focus Product Help > Install Missing Feature(s) > Feature Name.

Follow the instructions in the installer to install the missing feature.
3. Alternatively, if a Micro Focus project template requires a Visual Studio feature which is not currently

installed, the IDE displays an information bar with instructions to install the feature.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Visual COBOL client and a new licensing server on the same machine.
• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Other Requirements

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following packages: the Windows SDK package and the Microsoft Build Tools
package. See Microsoft Package Dependencies for a full list of actions and operations that require one or
both of these packages.
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By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location, use
the cblms command line utility post-installation to manage this; see Managing the Microsoft Build Tools
and Windows SDK Packages for more information.

System Requirements for Visual COBOL for Eclipse (Windows)

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Visual COBOL

2.6GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Also note the following:

• A 64-bit Windows is required. Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit
Windows, the setup file does not install some of the components. See Issues with the Installation in
Known Issues and Restrictions.

You can produce both 64-bit and 32-bit applications with Visual COBOL on 64-bit operating systems.

• Visual COBOL Build Tools for Windows x64 is only supported on Windows 10 or Windows Server 2019
operating systems.

• The Server Core form of Windows Server 2019 is not supported.

Software requirements

Note: This product includes OpenSSL version 1.1.1n-mf6 (modified).

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Requirements for the setup file

• A 64-bit Windows is required. Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit
Windows, the setup file does not install some of the components. See Issues with the Installation in
Known Issues and Restrictions.

• The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.20 (2021-06).

Visual COBOL only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to create both
32-bit and 64-bit applications.

• The setup file installs Adoptium's OpenJDK Temurin 11.
• The setup file also installs Microsoft's Visual C++ 2012 and 2017 Redistributables.
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Requirements for running the product

• Java 11 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is Adoptium's
OpenJDK Temurin 11 (LTS) with HotSpot, which the Windows product installs automatically. You can
download Adoptium's OpenJDK Temurin 11 (LTS) with HotSpot from Adoptium's Web site and unpack
the archive anywhere on your machine.

• Visual COBOL requires a 64-bit Java installation to run a 64-bit Eclipse.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following packages:
the Windows SDK package and the Microsoft Build Tools package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblms command line utility post-installation to manage this; see Managing the Microsoft Build
Tools and Windows SDK Packages for more information.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Visual COBOL client and a new licensing server on the same machine.
• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

System Requirements for Visual COBOL for Eclipse (UNIX)

Hardware Requirements for Visual COBOL for Eclipse

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x86-64
running Red
Hat Linux

Micro Focus 1.45 GB 5.78 GB 2.89 GB 50 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x86-64
running
CentOS

Micro Focus 1.45 GB 5.78 GB 2.89 GB 50 MB

x64 running
SUSE SLES

Micro Focus 1.29 GB 5.15 GB 2.57 GB 50 MB

System Z
running SUSE
SLES

Micro Focus 856 MB 3.42 GB 1.71 GB 50 MB

Amazon Linux
2

Micro Focus 1.29 GB 5.15 GB 2.57 GB 50 MB

x64 running
Ubuntu

Micro Focus 1.37 GB 5.45 GB 2.73 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements

The setup file requires that the following software and libraries are installed before you start the installation,
and that certain environment variables are set.

• Software required by the setup file
• Libraries required by the setup file
• Required environment variables
• Software installed by the setup file
• Requirements for running the product
• License Manager requirements

Software required by the setup file

The following software must be installed in advance:

• Java versions 11 through 15 from Adoptium (such as the Adoptium OpenJDK Temurin 11 (LTS) with
HotSpot) and Oracle are required for Visual COBOL for Eclipse.

• The unzip utility.
• The "awk", "ed", "ps", "sed", tar", "sed", and "which" utilities must be installed and added to the PATH.
• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use

Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.

Libraries required by the setup file

The 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating Systems for this
product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.
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Library Bitism Platform

32-
bit

64-
bit

SUSE 121 SUSE 151 Red Hat 7 Red Hat 8 Ubuntu
20.4

Amazon
Linux 2

glibc2 X X X X X

libgcc X X X X X

libgc1c2 X X

libstdc++ X X X X X

glibc-locale3 X X X X

libXtst6 X X X X

libXtst X X X X

glibc-devel X X X

gtk3 X X7 X7 X7

PackageKit-
gtk3

X X7 X7 X7

libcanberra-
gtk3

X X7 X7 X7

webkitgtk3 X X7 X7

webkit2gtk3 X X7

xterm Any
versi
on

Any
versi
on

X X X X

unzip Any
versi
on

Any
versi
on

X X X X

libgnome X X

libgtk-3-0 X X7 X7 X

gtk3-tools X X7 X7

gcc45 X X X X X X X

cpp4 X X X X

libnotify-tools6 X X X X

libnotify X X

libjasper1 X X X

libjasper4 X X

Note:

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On SUSE 12 or 15, you can only install the 64-bit version of Visual COBOL. The glibc-locale-32bit

library is still required by the SafeNet licensing components.
• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the

GNU Project Debugger) can be installed from the install media for your OS.
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• 2The glibc-locale-32bit library is only required if you want to install the SafeNet licensing
components. If this is present, the installer installs and configures both SafeNet and AutoPass
licensing. If glibc-locale-32bit is not installed, the installer only installs AutoPass licensing.

• 3On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 4On Red Hat, these libraries are required to enable COBOL to compile.
• 5On Red Hat, only the 64-bit gcc libraries are required.
• 6For SUSE 12 and later, you might need to install the Notifications Library tools (libnotify-tools).

This is to enable notifications to be displayed by the notify-send tool when starting Visual COBOL
for Eclipse from a desktop icon. Execute the following command to install the libnotify-tools library:

zypper install libnotify-tools

• 7The minimum GTK support required is 3.22. Certain platforms meet this requirement without the
need of installing the libraries manually; for example Red Hat 7.4 and SUSE 12 SP3.

Required environment variables

Before you start the installation, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

Software installed by the setup file

• The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.20 (2021-06). After the
installation, you can install Visual COBOL as a plug-in into other Eclipse 4.20 (2021-06) instances
available on the same machine - see Installing Visual COBOL into other instances of Eclipse.

Note: On SUSE platforms, you can only use the 64-bit version of Eclipse to produce 64-bit
applications; on other 64-bit platforms, you can use Eclipse to produce both 32-bit and 64-bit
applications.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

Requirements for running the product

• Java 11 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is Adoptium's
OpenJDK Temurin 11 (LTS) with HotSpot, which the Windows product installs automatically. You can
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download Adoptium's OpenJDK Temurin 11 (LTS) with HotSpot from Adoptium's Web site and unpack
the archive anywhere on your machine.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Visual COBOL client and a new licensing server on the same machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

System Requirements for Visual COBOL Development Hub

Hardware Requirements

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

POWER
running AIX

Micro Focus 806 MB 3.22 GB 1.61 GB 41 MB

System Z
running Red
Hat Linux

Micro Focus 409 MB 1.64 GB 818 MB 39 MB

x86-64
running Red
Hat Linux

Micro Focus 814 MB 2.26 GB 1.63 GB 50 MB

64 running
Red Hat Linux

Micro Focus 502 MB 2 GB 1 GB 50 MB

Red Hat for
Docker

Micro Focus 652 MB 2.61 GB 1.3 GB 50 MB

Amazon x64 Micro Focus 655 MB 2.62 GB 1.31 GB 50 MB

Amazon for
Docker

Micro Focus 652 MB 2.61 GB 1.3 GB 50 MB

SPARC
running
Solaris

Micro Focus 683 MB 2.73 GB 1.37 GB 42 MB

x86-64
running
Solaris

Micro Focus 685 MB 2.74 GB 1.37 GB 33 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

System Z
running SUSE
SLES

Micro Focus 417 MB 1.67 GB 834 MB 39 MB

x64 running
SUSE SLES

Micro Focus 655 MB 2.62 GB 1.31 GB 50 MB

SUSE for
Docker

Micro Focus 654 MB 2.62 GB 1.31 GB 50 MB

x64 running
Ubuntu

Micro Focus 734 MB 2.94 GB 1.47 GB 50 MB

Ubuntu for
Docker

Micro Focus 657 MB 2.63 GB 1.31 GB 50 MB

x86-64
running
CentOS

Micro Focus 814 MB 3.26 GB 1.63 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements

Note: This product includes OpenSSL version 1.1.1n-mf6 (modified).

The following topic lists the software requirements for Visual COBOL Development Hub.

• Software required by the setup file
• Libraries required by the setup file
• Required environment variables
• License Manager requirements

Software required by the setup file

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use
Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

Libraries required by the setup file

The following table lists the required libraries for Red Hat and SUSE Linux platforms. The setup file checks
that both the 32-bit and 64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.
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If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

The following table shows which of the required libraries are not installed by default on the specified platforms - X
indicates the libraries are missing.

Library Platform

32-
bit

64-bit s390 SUSE
12¹

SUSE 15 Red Hat
7

Red Hat 8 CentOS 7 Ubuntu 18
and 20

glibc2 X X X X X X

libgcc X X X X X X

libstdc++ X X X X X X

glibc-devel X X X X X

gcc3, 4 X X X X X X X X

cpp3 X X X X

libgc1c2 X X

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• ¹On SuSe 12 or 15, you can only install the 64-bit version of this product. The glibc-locale-32bit library is

still required by the SafeNet Sentinel licensed components.
• 2On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 3On Red Hat, these libraries are required to enable COBOL to compile.
• 4On Red Hat, only the 64-bit gcc libraries are required.

Visit the Red Hat Web site for more information.

Required environment variables

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.
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License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Visual COBOL client and a new licensing server on the same machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Issues with the Installation on UNIX and Linux
• If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without

loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.

Installing on Linux

On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Visual COBOL.

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.
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To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Product Co-Existence
Note: The following applies to Windows only.

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

Installing Visual COBOL for Visual Studio
To install this product:

1. Run the vcvsnnnn_80.exe file (where nnnn is the version of Visual Studio you're installing for) and
follow the wizard instructions to install the prerequisite software and the product.

2. After installing the Visual Studio 2022 product, you need to execute the following command from a
Visual Studio command prompt:

devenv /updateconfiguration

This fixes an issue with Microsoft's Visual Studio installer in Visual Studio 2022, release 17.2.n, that
might result in the IntelliSense and editor colorization not working.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features,
and rerun the installation file.

• Depending on how you plan to use the product, there could be dependencies on the Microsoft
Windows SDK and Microsoft Build Tools packages. The installer will install the latest versions of
the Microsoft Windows 10 SDK, and the Microsoft Build Tools for Visual Studio 2017, to their
default locations. Refer to Microsoft Package Dependencies to see if you will require these
packages, and if not, you can configure the installer to skip download and installation (see
Advanced Installation Tasks for more information).
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• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus Customer Care to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing Visual COBOL for Eclipse (Windows)
Note:

• This version of the product is a full install.
• If you have an earlier version of Visual COBOL installed on your machine, check Installing as an

Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL:

1. Run the vce_80.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.20 (2021-06) 64-bit, with the Micro Focus plugins
already installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks.

Installing Visual COBOL for Eclipse (UNIX)
These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_deveclipse_8.0_platform

2. Run the setup file with superuser permissions:

./setup_visualcobol_deveclipse_8.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_deveclipse_8.0_platform -installlocation="full path of 
new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.
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Installing Visual COBOL Development Hub
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_devhub_8.0_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_devhub_8.0_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

Enterprise Server System Administrator Process

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server processes
except the one for the Micro Focus Directory Server (MFDS). The Directory Server process (Enterprise
Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the Process
User ID which can affects the file access and creation.

You must supply the user ID at the command line - specify -EsadminID=[ ID ] as part of your
command.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh and follow the
onscreen instructions.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_visualcobol_devhub_8.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force
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AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web

site for any documentation updates.
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Licensing Information
Note:

• Personal Edition licensing is only available with Visual COBOL for Visual Studio 2022 and Visual
COBOL for Eclipse.

• When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid full license of Visual COBOL in order to continue using the product.

• This package provides a license per supported Micro Focus Development Hub platform.
• If you have purchased licenses for a previous release of this product, those licenses will also

enable you to use this release.
• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,

contact your sales representative or Micro Focus Customer Care.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus Customer Care.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

Windows: To start the GUI Micro Focus License Administration

Windows 10 From your Windows desktop, click Start > Micro Focus License Manager > License
Administration.

Windows 11 Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start License Administration.

Windows: To start the command-line Micro Focus License Administration tool

1. At a command prompt, navigate to:

C:\Program Files (x86)\Micro Focus\Licensing

2. Type cesadmintool.bat, and press Enter.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need a license file (with an .xml extension for AutoPass licenses). You need to install AutoPass
licenses into the existing Micro Focus License Administration tool, and not in the AutoPass License Server.
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If you have a license file

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .xml).

• Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.
2. Click Help > Micro Focus Product Help > Product LicensingHelp > Micro Focus > Product

Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Visual COBOL license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .xml), and then click Open.
6. Click AuthorizeFinish to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus Customer Care.
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Updates and Customer Care
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any
patch updates.

6. Click Download on the relevant row.
• The Examples and Utilities section of the Micro Focus Customer Care Web site, including demos and

additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

• The Support Resources section of the Micro Focus Customer Care Web site, that includes
troubleshooting guides and information about how to raise an incident. Go to https://
supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Login.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product. See Micro Focus Channel on
YouTube.

https://www.microfocus.com/en-us/resource-center/webinar
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https://sld.microfocus.com/mysoftware/download/downloadCenter
HTTPS://SLD.MICROFOCUS.COM/MYSOFTWARE/DOWNLOAD/DOWNLOADCENTER
HTTPS://SLD.MICROFOCUS.COM/MYSOFTWARE/DOWNLOAD/DOWNLOADCENTER
https://supportline.microfocus.com/examplesandutilities/index.aspx
https://supportline.microfocus.com/examplesandutilities/index.aspx
https://supportline.microfocus.com/supportresources.aspx
https://supportline.microfocus.com/supportresources.aspx
https://www.microfocus.com/en-us/home/
https://www.microfocus.com/support-and-services/contact-support/
https://community.microfocus.com
https://www.youtube.com/microfocus
https://www.youtube.com/microfocus


Information We Need
If your purpose in contacting Micro Focus is to raise a support issue with Customer Care, you should
collect some basic information before you contact us, and be ready to share it when you do.

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
Micro Focus Customer Care, in the product help for Visual COBOL for Eclipse (Windows).

See the Preparing to Raise a Support Case topic on the Product Documentation pages on Micro Focus
Customer Care, in the product help for Visual COBOL for Visual Studio 2017 (click here), or Visual COBOL
for Visual Studio 2019 (click here), or Visual COBOL for Visual Studio 2022 (click here).

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
Micro Focus Customer Care, in the product help for Visual COBOL for Eclipse (UNIX).

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus Customer
Care, your support representative might request that you provide additional debug files (as well as source
and data files) to help us determine the cause of the problem. If so, they will advise you how to create
them.
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https://www.microfocus.com/documentation/visual-cobol/vc80/EclWin/GUID-1674F9FE-E6BF-4685-A381-D6514E2016B9.html
https://www.microfocus.com/documentation/visual-cobol/vc80/VS2017/GUID-1674F9FE-E6BF-4685-A381-D6514E2016B9.html
https://www.microfocus.com/documentation/visual-cobol/vc80/VS2019/GUID-1674F9FE-E6BF-4685-A381-D6514E2016B9.html
https://www.microfocus.com/documentation/visual-cobol/vc80/VS2022/GUID-1674F9FE-E6BF-4685-A381-D6514E2016B9.html
https://www.microfocus.com/en-us/documentation/visual-cobol/VC80/EclUNIX/GUID-1674F9FE-E6BF-4685-A381-D6514E2016B9.html


Copyright and Disclaimer
© Copyright 2022 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.

Copyright and Disclaimer | 69


	Contents
	Micro Focus Visual COBOL Developer 8.0 Release Notes
	What's New
	Micro Focus COBOL Extension for Visual Studio Code
	.NET 6 Support
	COBOL Language
	Code Analysis
	Compiler Directives
	Data File Tools
	Debugging Applications
	Eclipse
	Enterprise Server
	Enterprise Server Common Web Administration (ESCWA)
	Enterprise Server Security
	Micro Focus Unit Testing Framework
	OpenESQL
	Visual Studio

	Significant Changes in Behavior or Usage
	Known Issues
	Resolved Issues
	Other Issues Resolved in This Release
	Unsupported or Deprecated Functionality
	Installation
	Before Installing
	Downloading the Product
	System Requirements
	System Requirements for Visual COBOL for Visual Studio
	Hardware Requirements
	Operating Systems Supported
	Software Requirements

	System Requirements for Visual COBOL for Eclipse (Windows)
	Hardware Requirements
	Operating Systems Supported
	Software requirements

	System Requirements for Visual COBOL for Eclipse (UNIX)
	Hardware Requirements for Visual COBOL for Eclipse
	Operating Systems Supported
	Software Requirements

	System Requirements for Visual COBOL Development Hub
	Hardware Requirements
	Operating Systems Supported
	Software Requirements

	Issues with the Installation on UNIX and Linux

	Product Co-Existence

	Basic Installation
	Installing Visual COBOL for Visual Studio
	Installing Visual COBOL for Eclipse (Windows)
	Installing Visual COBOL for Eclipse (UNIX)
	Installing Visual COBOL Development Hub

	After Installing

	Licensing Information
	To buy and activate a full unlimited license
	To start Micro Focus License Administration
	Installing licenses
	If you have a license file

	To obtain more licenses

	Updates and Customer Care
	Further Information and Product Support
	Information We Need
	Creating Debug Files

	Copyright and Disclaimer

